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notices and acknowledgments 

hewlett-packard company notices
The information contained in this document is subject to change without 
notice.

Hewlett-Packard (HP) makes no warranty of any kind with regard to this 
material including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose.

Hewlett-Packard shall not be liable for any errors or for incidental or 
consequential damages in connection with the furnishing, performance, or 
use of this material.

All rights reserved. Reproduction, adaptation, or translation of this material 
is prohibited without prior written permission of Hewlett-Packard, except as 
allowed under copyright laws.

acknowledgments
Microsoft, MS, MS-DOS, and Windows are registered trademarks of 
Microsoft Corporation.

Pentium is a U.S. registered trademark of Intel Corporation.

TrueType is a U.S. trademark of Apple Computer, Inc.

Adobe and Acrobat are trademarks of Adobe Systems Incorporated.

Palm, Palm III, Palm V, and Palm VII are trademarks of Palm, Inc.

Copyright 2001 Hewlett-Packard Company
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terms and conventions 
The following terms and word conventions are used in the onscreen User’s 
Guide.

terms
The hp color inkjet printer cp1160 is referred to as hp cp1160 or printer.

symbols
The > symbol guides you through a series of software steps.
For example: 

Click File > Print > Setup, then select Properties.

cautions and warnings
A Caution indicates possible damage to the printer or to other equipment. For 
example:

Caution! Do not touch the printhead ink nozzles or copper contacts. 
Touching these parts will result in clogs, ink failure, and bad electrical 
connections. 

A Warning indicates possible harm to yourself or to others. 
For example:

Warning! Keep ink cartridges out of the reach of children.
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icons
A Note icon indicates that additional information is provided. For example:

A Mouse icon indicates that additional information is available through the 
What’s This? help feature.

For best results use HP products.

To find more information about options on each tab screen, point to an 
option and click the right mouse button to display the What’s This? dialog 
box. Click What’s This? to view more information about the selected 
option.
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using the onscreen user’s guide
This onscreen User’s Guide is viewed through Adobe Acrobat Reader 4.0.

1. View Buttons: Click these buttons to change page views:
 View the page in actual size
 Fit the page in the window.
 Fit the page width in the window.

2. Zoom:  Use to zoom in on a page.

3. Bookmarks: Click a bookmark to view a topic.

4. Navigation Buttons: Click these buttons to navigate:
 Go to the first page of the document.
 Go back one page.
 Go forward one page.
 Go to the last page of the document.
 Go to the previous view.
 Go to the next view.

�

�

�
�
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getting started
• your hp color inkjet printer cp1160

• printer features

• LCD panel

• buttons and lights

• infrared lens

• paper tray

• ink delivery system

• automatic paper-type sensor

• automatic two-sided printing module (duplexer)

• connectivity
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your hp color inkjet printer cp1160
Congratulations! You have purchased an hp color inkjet printer cp1160 
which is equipped with features designed to make the printer easy to use and 
the output look outstanding:

• Print speeds of up to 17 pages per minute for black text in draft mode 
and 8 pages per minute in normal mode

• Automatic two-sided printing
• An LCD panel for monitoring the printer’s status
• An easy-access front door for replacing ink cartridges
• Greater flexibility in connectivity using a USB cable, a parallel cable, 

or an optional LIO Ethernet module for easy network setup
• Better print quality using the Automatic Paper-Type Sensor
• Optional 250-sheet plain paper tray

HP printers are designed to help you get the best results for your printing 
needs. Read about these and other features in the following sections.

During the initial start up of this printer, the ink is automatically filled into 
the printer's ink distribution system. This operation typically takes nine 
to ten minutes to complete. The user will notice movement of the printing 
mechanism and may notice an odor during this operation. These are not 
indications that the printer is malfunctioning. This operation occurs only 
upon initial start up of the printer, and not during subsequent use or 
startups.
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printer features 
The printer has several features designed to make it easy to use. To learn 
about a feature, click the name of the feature below:

1. LCD panel

2. buttons and lights

3. infrared lens

4. paper tray

5. ink delivery system

6. automatic paper type sensor

�

�
�

�

�

�
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7. automatic two-sided printing module (duplexer)

8. connectivity

�
�
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LCD panel 
The LCD panel displays icons to show the printer’s status.

Each icon represents one of the following:

• An operating condition of the printer (such as an error)
• A physical part of the printer (such as the paper tray)

By combining these types of icons, the LCD panel shows the printer’s status.
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operating condition icons
The LCD panel displays icons that show the printer’s operating condition.

The printer needs attention. Other icons on 
the LCD panel flash when the alert icon 
appears to indicate that attention is needed.

The printer is busy. It may be receiving data. 
This icon represents a normal operating 
condition.

The printer is printing a two-sided document.

The printer is printing a banner.

The printer has established an infrared link 
with another device.

The printer has encountered a communication 
problem either with a direct connection to an 
individual computer or with a network.
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ink cartridges
The LCD panel displays one icon for each ink cartridge.

1. black ink cartridge 
2. tri-color ink cartridge

When replacing ink cartridges and printheads, purchase ink 
cartridges and printheads with selection no. 14.

For more information, see ink cartridge selection numbers.

� �
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ink level gauge

The Ink Level Gauge shows you when one or both of the ink cartridges are 
functioning properly, very low on ink, or out of ink.

Full.

Hall full.

Very low on ink. Last portion of ink level flashes. Replace 
soon.

Out of ink. Replace immediately.
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expired ink

The LCD panel indicates when an ink cartridge will expire soon or is expired.

For an explanation of ink expiration, see expired ink cartridges.

To see instructions for replacing an ink cartridge, see replacing ink 
cartridges.

Will expire soon. Ink level may vary. Replace soon.

Expired. Ink level may vary. Replace immediately.
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printheads
The printhead icons appear when a printhead needs to be replaced. The 
printhead that needs to be replaced flashes.

For a description of the printheads, see printheads.

1. cyan 
2. black 
3. magenta 
4. yellow

When replacing ink cartridges and printheads, purchase ink 
cartridges and printheads with selection no. 14.

For more information, see printhead selection numbers.

�

�

�

�
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normal operation conditions
Under normal operating conditions, the LCD panel displays the printer and 
the ink cartridge icons (ink levels may vary).

When the printer is receiving data, the hourglass icon appears (ink levels 
may vary).

error messages
When the printer encounters an error, the alert icon appears and one or 
more icons flash to indicate the source of the error. In the example below, the 
top printer door has been left open for too long.

For more information on error messages, see LCD panel error messages.
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buttons and lights
The printer buttons let you turn the printer on and off, cancel a print job, or 
resume printing. The lights give you visual cues about the status of the printer.

1. cancel button 
2. resume button and light 
3. power button and light

cancel button
Pressing this button cancels the current print job.

resume button and light
The Resume light flashes when an action is required such as loading paper 
or clearing a paper jam. When the problem is solved, press the Resume 
button to continue printing. 

�

�
�
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power button and light
The Power button turns the printer on and off. It may take a few seconds for 
the printer to turn on after pressing the Power button. The green light next to 
the Power button flashes when the printer is busy.

Caution! Always use the Power button on the front of the printer to turn 
the printer on and off. Using a power strip, surge protector, or a wall-
mounted switch to turn the printer on and off may cause printer failure.
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infrared lens 
The printer has a special Infrared (Ir) lens. The Infrared lens allows printing 
from an infrared sending device such as a Palm device, laptop, or notebook 
computer.

For a full description of infrared printing, see infrared printing.
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paper tray 
The printer comes with a 150-sheet capacity paper tray. The paper tray can 
be removed from the printer.

1. paper tray top 
2. put paper here for printing

Additionally, the printer can also use an optional 250-sheet plain paper 
tray.

�

�
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loading the paper tray
The paper tray holds paper or other media to be printed. The length and 
width guides adjust to the size of the media being used.

For ease of loading, the paper tray top raises. Lower the top when printing.

1. paper width guide 
2. paper length guide
3. paper tray top up

To load a specific media type, see printing.

� �

�
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output
The printer deposits printed pages on top of the paper tray.

Pull the paper tray extension out to prevent the paper from falling off the tray. 
When the print job finishes, push the tray extension back into its storage slot.

1. printed pages are deposited here 
2. paper tray extension

�

�
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ink delivery system
The printer’s ink delivery system consists of these parts:

• Ink cartridges
• Printheads
• Print carriage

ink cartridges
Ink cartridges supply ink to the printer.

1. black ink cartridge 
2. tri-color ink cartridge

For installation instructions, see replacing ink cartridges.

For storage instructions, see maintaining ink cartridges.

� �
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printheads
The printer uses four printheads. The printheads apply ink to printable media.

1. cyan 
2. black 
3. magenta 
4. yellow

For installation instructions, see replacing printheads.

Caution! After installing printheads, do not open the print carriage 
unless a printhead needs to be replaced. Opening the print carriage 
needlessly can damage the printheads.

� �� �
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print carriage
The print carriage is the main operating feature of the printer’s ink delivery 
system. It holds the two ink cartridges and the four printheads.

1. ink cartridges 
2. printheads

Caution! Do not open the print carriage unless a printhead needs to be 
replaced or you are asked to by an HP support agent. Opening the print 
carriage needlessly can damage the printheads.

�

�
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automatic paper-type sensor 
The Automatic Paper-Type Sensor automatically determines the correct paper 
type and adjusts the print settings for most paper or media placed in the 
paper tray. 

This feature, particularly when used with HP paper and media, provides 
better printing results.

When the Automatic Paper-Type Sensor is engaged, the printer scans the first 
page of a document with a blue optical sensor light to determine the best 
paper type setting. Once determined, the page is printed.

To see instructions for using the Automatic Paper-Type Sensor, see using the 
automatic paper-type sensor.
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automatic two-sided printing module 
(duplexer)
The Automatic Two-Sided Printing Module (duplexer) is a special hardware 
feature that enables the printer to automatically print on both sides of a page.

installing the duplexer
1. Turn the latch counter-clockwise on the printer’s Rear Access Door and 

remove the door.

Do not discard the Rear Access Door. In order to print, the duplexer or 
the Rear Access Door must be attached to the printer.
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2. Insert the duplexer in the back of the printer until both sides snap into 
place.
Do not press the buttons on either side of the duplexer when installing it 
in the printer. Use these buttons only when removing the duplexer from 
the printer.

If you encounter a problem using the duplexer, see two-sided printing 
problems.

For Automatic Two-Sided Printing Module specifications, see automatic two-
sided printing module specifications.
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supported paper types
Not all paper types, weights, and sizes can be used with the duplexer. Use 
one of the paper types listed below when using the duplexer.

• hp plain paper
• hp bright white inkjet paper
• hp premium inkjet heavyweight paper
• hp felt-textured greeting card paper
• hp professional brochure paper, glossy or matte
• hp photo quality inkjet paper, semi-gloss or matte

printing with the duplexer
For two-sided printing instructions, see two-sided printing.



25

connectivity
The printer offers a number of options for connectivity, including:

• USB

• parallel

• network connections

For the latest updates on connectivity for your hp cp1160, visit 
www.hp.com.

http://www.hp.com
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USB
The printer can connect to your computer with a USB cable if your computer 
is running Windows 98, Me, or 2000.

1. USB cable 
2. USB receptacle

For instructions on connecting the printer with a USB cable, see the Setup 
poster that came with the printer.

For supply numbers, see interface cables.

� �
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parallel
The printer can connect to your computer with a parallel cable via a parallel 
cable adapter and the LIO slot.

1. centronix parallel cable (IEEE 1284)
2. parallel cable adapter 
3. LIO slot

For instructions on connecting with a parallel cable, see the Setup poster that 
came with the printer.

For supply numbers, see interface cables.

�

�
�
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network connections
The printer can connect to a network with an LIO module.

1. ethernet cable
2. LIO module
3. LIO slot

For instructions on connecting with an LIO module, see the Setup poster that 
came with the printer or the documentation that came with the LIO module.

HP offers a number of LIO modules to connect the printer to several different 
types of networks via the LIO slot. 

For available LIO modules, see LIO modules.

�

�
�
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To see more information on the printer’s networking feature:

1. Insert the CD that came with the printer into your computer’s CD-ROM 
drive.

1. Click View Documentation.

2. Click Networking.

3. Select one of the following options:
• Network Basics Tutorial - A brief introduction to networks and network 

printing.
• Network User’s Guide - Setup and configuration information for LIO 

print servers.
• Network Troubleshooting - Troubleshooting steps for LIO network 

printing connections.

You can also visit HP’s Website:

• Technical support: http://www.hp.com/support/net_printing
• Product information: http://www.hp.com/go/networkprinting

http://www.hp.com/support/net_printing
http://www.hp.com/go/networkprinting
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printing
For an explanation of the printer software, click the following:

• printer properties

For instructions about printing functions, click the appropriate topic below:

• changing default printer properties

• printing a document

• two-sided printing

• using the automatic paper-type sensor

• watermarks

For instructions on printing on a specific type of media, click the appropriate 
media type below:

• plain paper

• envelopes

• transparencies

• labels

• index cards and other small media

• photographs

• greeting cards

• posters

• banners

• iron-on transfers

For instructions on infrared printing, click the following:

• infrared printing
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printer properties
The printer is controlled by software installed on your computer. Use the 
printer software, also called the “printer driver”, to change the print settings 
for a document.

displaying the printer properties dialog box
Follow these steps to display the Printer Properties dialog box:

1. Open the file you want to print.

2. Follow one of these paths to select the Printer Properties dialog box 
depending on the software program you are using:
• Click File > Print, then select Properties.
• Click File > Print Setup, then select Properties.
• Click File > Print > Setup, then select Properties.
The Printer Properties dialog box appears.
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using the printer properties dialog box
The Printer Properties dialog box has several tools to make it easy to use.

1. Tabs: Click a tab to see its contents. To see a description of a 
specific tab, see setup, features, color, or services.

2. Preview: Shows how changes to the print settings affect the 
document.

3. Buttons:
• OK: Saves and applies settings.
• Cancel: Closes dialog box without saving new settings.
• Help: Opens online help.
• Factory Settings: Restores default print settings.

The Printer Properties dialog box may display an Apply button. The 
Apply button saves changes to settings without closing the dialog box.

�

�

�
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tabs

setup

The Setup tab allows you to set these options:

1. Print Quality: Quality and print speed.

2. Orientation: Page layout.

3. Rotate 180º: Use with envelopes and Hagaki cards.

4. Use Different First Page: Paper type, paper size, and paper tray for 
the first page of a document.

5. Paper Type: The type of paper used.

6. Paper Size: The size of paper used.

7. Photo Paper Printing: Quality of photo printing on certain photo 
papers.

8. Scale to Fit: Size of text and images on a page.

�
�

�

�

�
�
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features

The Features tab allows you to set these options:

1. Two-Sided Printing: See two-sided printing.

2. Pages per Sheet: Number of pages printed on each sheet of paper.

3. Poster Printing: Number of sheets of paper used to print a poster.

4. Advanced Features: Ink volume and dry time.

5. Watermark: See watermarks.

6. Copies: Number of copies printed.

7. Start Printing from Last Page: Print order.

�

�

�

�
�

�
�
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color

The Color tab allows you to set these options:

1. Print in Grayscale: Print in shades of gray.

2. Saturation: Intensity of printed colors.

3. Brightness: Lightness or darkness of printed colors.

4. Color Tone: Warmth or coolness of printed colors.

5. Automatic Image Enhancement: Automatic Contrast Enhancement and 
Fixed Resolution Enhancement.

To find more information about options on each tab screen, point to an 
option and click the right mouse button to display the What’s This? dialog 
box. Click What’s This? to view more information about the selected 
option.

�

�
�
�

�
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services

The Services tab allows you to open the Toolbox.

1. Open the HP Toolbox: Click this button to open the Toolbox.

To see a description of the Toolbox, see toolbox.

�
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changing default printer properties
The taskbar icon allows you to adjust default printer properties. Default 
printer properties apply to all documents that you print.

1. taskbar icon
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setting default print quality and two-sided printing

1. Click the taskbar icon.
The Default Printer Settings dialog box appears.

2. Select from the available print options:
• Print Quality: Best, Normal, or Draft.
• Automatic Two-Sided Printing: Check to use the duplexer.

3. Click outside of the dialog box.
A dialog box appears advising that the selections made determine what 
printer properties the printer will use when printing. If you do not want to 
see this dialog box again, select Don’t show me this message again.

4. Click OK.

setting default printer properties

1. Double-click the taskbar icon.
The Printer Properties dialog box appears.

2. Select from the available print options.

3. Click OK.
A dialog box appears advising that the selections made determine what 
printer properties the printer will use when printing. If you do not want to 
see this dialog box again, select Don’t show me this message again.

4. Click OK.

To see a description of the Printer Properties dialog box, see printer 
properties.
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selecting a default printer

Use this feature to select a default printer if you have more than one printer 
installed on your computer.

1. Right-click the taskbar icon.
A list of available printers appears.

2. Select the printer you want.
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printing a document
Follow these instructions to print a document:

1. Open the file you want to print.

2. Follow one of these paths to open the Printer Properties dialog box:
• Click File > Print, then select Properties.
• Click File > Print Setup, then select Properties.
• Click File > Print > Setup, then select Properties.
The Printer Properties dialog box appears. 

3. Select the Setup tab to choose print quality options, paper source (if 
applicable), page orientation, automatic paper-type sensor or a specific 
paper type, paper size, and photo paper printing.

4. Select the Features tab to choose two-sided printing, watermarks, multiple 
pages per sheet, and poster printing.

5. Select the Color tab to make color and contrast adjustments.

6. Select the Services tab to open the Toolbox.

7. Click OK to return to the Print or Print Setup screen.

8. Click OK to print.
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two-sided printing
Use one of the following methods to print two-sided documents:

• automatic two-sided printing
• manual two-sided printing



42

automatic two-sided printing
To print two-sided documents automatically, the duplexer must be attached 
to the printer.

The duplexer only works with certain media types. For a list of supported 
media types, see duplexer media types.

If you want to print a two-sided document on a media type not supported by 
the duplexer, see manual two-sided printing.

printing instructions

Follow these instructions to print a two-sided document:

1. Open the Printer Properties dialog box, then select the Features tab.

2. Check Two-Sided Printing.
The Two-Sided Printing Margin dialog box appears.

3. Select the appropriate page content option, then click OK to return to the 
Features tab.

4. Select the Automatic box.
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5. Select Book or Tablet.

6. Change any other desired print settings, then click OK.

When the first side prints, the printer pauses while the first side of the printed 
page dries. Once dry, the second side of the page is printed and released 
to the top of the paper tray.

For a description of the duplexer, see automatic two-sided printing module 
(duplexer).

If you encounter a problem while printing a two-sided document, see
two-sided printing problems.
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manual two-sided printing
Use the manual two-sided printing feature if:

• The duplexer is not attached to the printer
• You want to print a two-sided document on a media type the duplexer 

does not support

rear access door

If the duplexer is not attached to the printer, the printer cannot feed paper 
unless the Rear Access Door is attached.

1. Push the Rear Access Door into place.
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2. Turn the latch to the right to attach the Rear Access Door to the printer.
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printing instructions

Follow these instructions to print a two-sided document manually:

1. Open the Printer Properties dialog box, then select the Features tab.

2. Check Two-Sided Printing.
The Two-Sided Printing Margin dialog box appears.

3. Select the appropriate page content option, then click OK to return to the 
Features tab.

4. Deselect the Automatic box.

5. Select Book or Tablet.

6. Change any other desired print settings, then click OK.
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7. The printer automatically prints odd-numbered pages first. Once the 
odd-numbered pages are printed, a message appears prompting you to 
reload the paper so that the even-numbered pages can be printed.

book binding

tablet binding

8. Reload the paper, then click Continue.
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using the automatic paper-type sensor

activating the automatic paper-type sensor
Open the file you want to print, follow the basic printing procedures and 
select the following option:

turning off the automatic paper-type sensor
Open the file you want to print, follow the basic printing procedures and 
select the following option:

For a description of the Automatic Paper-Type Sensor, see automatic paper-
type sensor.

tab setting

Setup Paper Type: Automatic

tab setting

Setup Paper Type: Any paper type other than Automatic.
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watermarks
Watermarks appear as background printing on documents.

applying an existing watermark to a document

Follow these steps to apply an existing watermark to a document:

1. Open the Printer Properties dialog box.

2. Click the Features tab.

3. Select the watermark you want from the Current Watermarks list.

4. Do one of the following:
• If you want the watermark to appear on the first page only, select First 

Page Only.
• If you want the watermark to appear on all printed pages, leave First 

Page Only unchecked.

5. Print the document according to the instructions for the paper type.
For printing instructions about specific paper types, see printing.

creating or changing a watermark

Follow these steps to create or change a watermark:

1. Open the Printer Properties dialog box.

2. Click the Features tab.
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3. Click the Edit button.
The Watermark Details dialog box appears.

4. Do one of the following:
• To create a watermark, click New.
• To change a watermark, select the watermark.

5. Create or change the watermark message, message angle, and font 
attributes as you want.

6. After you have set the watermark details, click OK.

7. Apply the watermark.

See applying an existing watermark to a document.

To find more information about options on each tab screen, point to an 
option and click the right mouse button to display the What’s This? dialog 
box. Click What’s This? to view more information about the selected 
option.
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plain paper 

1. Raise the top of the paper tray.

2. Slide out both paper guides.

3. Do one of the following:
• For executive, A4, and B5 sized paper, place the paper in the tray.
• For legal-sized paper, pull out the paper length guide, then place the 

paper in the tray.

4. Slide the paper guides snugly against the paper.

5. Lower the top of the paper tray, then pull out the paper tray extension.

1. executive, A4, and B5 paper sizes
2. legal-sized paper

preparing to print

�

�
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1. Open the Printer Properties dialog box, then select the following setting:

2. Select any other desired print settings.

3. After you have selected the print settings, click OK.

For basic printing instructions, see printing a document.

If you encounter a problem while printing, see troubleshooting.

printing on plain paper

tab setting

Setup • Paper Type: Automatic, or Plain Paper



53

envelopes 
Print a single envelope using the envelope slot, or print multiple envelopes 
using the paper tray.

• Avoid using envelopes that have clasps or windows.
• Avoid using envelopes that are shiny or embossed, envelopes with 

thick, irregular, or curled edges, or envelopes that are wrinkled, torn, 
or otherwise damaged.

• Align the envelope edges before inserting them in the paper tray.

1. Place the envelope—with the flap side on the left and facing up—into the 
single envelope slot. 

2. Push the envelope forward until it stops.

1. flap

printing guidelines

preparing to print a single envelope

�
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1. Raise the top of the tray. 

2. Slide out both paper guides and remove all paper from the tray.

3. Place no more than 15 envelopes—with the flap side on the left and 
facing up—in the tray. 

4. Push the envelopes forward until they stop.

5. Slide the paper guides snugly against the edges of the envelopes.

6. Lower the top of the tray, then pull out the paper tray extension.

preparing to print multiple envelopes
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If your software program includes an envelope-printing feature, follow the 
instructions provided with the software program.

1. Open the Printer Properties dialog box, then select the following settings:

2. Select any other desired print settings.

3. After you have selected the print settings, click OK.

For basic printing instructions, see printing a document.

If you encounter a problem while printing, see troubleshooting.

printing the envelopes

tab setting

Setup • Paper Type: Automatic or Plain Paper
• Paper Size: Appropriate envelope size
• Orientation: Appropriate envelope orientation
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transparencies 

For best results use hp premium plus transparency film.

1. Raise the top of the paper tray.

2. Slide out both paper guides, then remove all paper from the tray.

3. Fan the edges of the transparency sheets to separate them, then align the 
edges.

4. Place no more than 30 transparency sheets in the tray with the rough 
side down and the adhesive strip toward the printer.

5. Carefully push the transparencies forward until they stop so that none of 
the adhesive strips catch on one another.

6. Slide the paper guides snugly against the transparency sheets. 

7. Lower the top of the paper tray, then pull out the paper tray extension.

printing guidelines

preparing to print
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1. Open the Printer Properties dialog box, then select the following setting:

2. Select any other desired print settings.

3. After you have selected the print settings, click OK.

The printer may wait for transparencies to dry before releasing them to the 
top of the tray.

For basic printing instructions, see printing a document.

If you encounter a problem while printing, see troubleshooting.

printing transparencies

tab setting

Setup • Paper Type: Automatic, or appropriate transparency film
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labels 

• Use only paper labels that are designed specifically for inkjet printers.
• Use only full sheets of labels.
• Verify that the labels are not sticky, wrinkled, or pulling away from the 

protective backing.
• Do not use plastic or clear labels. The ink will not dry on these labels.

1. Raise the top of the paper tray.

2. Slide out both paper guides, then remove all paper from the tray.

3. Fan the edges of the label sheets to separate them, then align the label 
edges.

4. Load no more than 30 label sheets—label side down—in the tray. 

5. Slide the paper guides snugly against the sheets.

6. Lower the top of the paper tray, then pull out the paper tray extension.

printing guidelines

preparing to print
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If your software program includes a label-printing feature, follow the 
instructions provided with the software program.

1. Open the Printer Properties dialog box, then select the following settings:

2. Select any other desired print settings.

3. After you have selected the print settings, click OK.

For basic printing instructions, see printing a document.

If you encounter a problem while printing, see troubleshooting.

printing labels

tab setting

Setup • Paper Type: Automatic, or the appropriate paper type
• Paper Size: Choose A4 or Letter (8.5 x 11 in)
• Orientation: Appropriate orientation

Features • Two-Sided Printing: Unchecked
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index cards and other small media

Use only cards and small media that meet the printer’s paper size 
specifications. For the printer’s paper size specifications, see size 
specifications. 

1. Place the card into the single envelope slot. 

2. Push the card forward until it stops.

1. Pull out the paper tray, then raise the top of the paper tray.

2. Slide out both paper guides, then remove all paper from the tray.

3. Align the card edges.

4. Place no more than 60 cards in the tray.

printing guidelines

preparing to print a single index card and other 
small media

preparing to print multiple index cards and other 
small media
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5. Push the cards forward until they stop.

6. Slide the paper length guide all the way in, then slide the fine length 
guide snugly against the media. 

1. fine paper length guide

7. Slide the paper width guide snugly against the media.

8. Lower the top of the paper tray, insert the paper tray into the printer, then 
pull out the paper tray extension.

�
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If your software program includes a card-printing feature, follow the 
instructions provided by the software program.

1. Open the Printer Properties dialog box, then select the following settings:

2. Select any other desired print settings.

3. After you have selected the print settings, click OK.

If an out of paper message appears, verify the cards are positioned properly 
in the paper tray. 

For basic printing instructions, see printing a document.

If you encounter a problem while printing, see troubleshooting.

printing index cards and other small media

tab setting

Setup • Paper Type: Automatic or Plain Paper
• Paper Size: Appropriate card size
• Orientation: Appropriate orientation

Features • Two-Sided Printing: Unchecked for cards smaller than 
5in. × 8 in.
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photographs 

• The photo must be in an electronic format (digital) before it can be 
printed. Take a digital picture, scan a photo, or have your local 
camera shop provide an electronic file of the photo. 

• Use PhotoREt for most photo paper printing.
• Use hp premium plus photo paper or hp premium photo paper for best 

results.

1. Raise the top of the paper tray.

2. Slide out both paper guides, then remove all paper from the tray.

3. Fan the edges of the photo paper to separate them, then align the photo 
paper edges.

4. Place no more than 20 sheets of photo paper—printable side down—in 
the tray.

5. Slide the paper guides snugly against the edges of the photo paper.

6. Lower the top of the paper tray, then pull out the paper tray extension.

printing guidelines

preparing to print
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1. Open the Printer Properties dialog box, then select the following settings:

2. Select any other desired print settings.

3. After you have selected the print settings, click OK.

For basic printing instructions, see printing a document.

If you encounter a problem while printing, see troubleshooting.

printing photographs

tab setting

Setup • Paper Type: Automatic or the appropriate photo paper 
type

• Photo Paper Printing: 
- PhotoREt for best print speed and quality, or 
- 2400 x 1200 dpi for source images greater than 600 

dpi (requires 400 MB or more hard disk space and 
takes longer to print)

• Paper Size: Appropriate paper size

Features • Two-Sided Printing: Unchecked
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greeting cards 

Unfold pre-folded cards before placing them in the paper tray.

1. Pull out the paper tray, then raise the top of the paper tray.

2. Slide out both paper guides, then remove all paper from the tray.

3. Fan the edges of the greeting cards to separate them.

4. Align the edges of the cards, then place no more than 5 cards in the 
tray. 

5. Push the cards forward until they stop. 

6. Slide the paper width guide snugly against the edges of the cards.

7. Slide the paper length guide all the way in, then slide the fine length 
guide snugly against the cards.

1. fine paper length guide

8. Lower the top of the paper tray, insert the paper tray into the printer, then 
pull out the paper tray extension.

printing guidelines

preparing to print

�



66

If your software program includes a greeting card-printing feature, follow the 
instructions provided with the software program.

1. Open the Printer Properties dialog box, then select the following settings:

2. Select any other desired print settings.

3. After you have selected the print settings, click OK.

If an out of paper message appears, verify that the greeting cards are 
positioned properly in the paper tray.

For basic printing instructions, see printing a document.

If you encounter a problem while printing, see troubleshooting.

printing greeting cards

tab setting

Setup • Paper Type: Automatic, or appropriate greeting card 
paper

• Paper Size: Appropriate paper size
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posters 

1. Raise the top of the paper tray.

2. Slide out both paper guides, then remove all paper from the tray.

3. Fan the edges of the sheets to separate them, then align the edges.

4. Place the paper in the tray.

5. Slide the paper guides snugly against the paper.

6. Lower the top of the paper tray, then pull out the paper tray extension.

preparing to print



68

1. Open the Printer Properties dialog box, then select the following settings:

2. Select any other desired print settings.

3. After you have selected the print settings, click OK.

4. After the poster has printed, trim the edges on the sheets then tape the 
sheets together.

For basic printing instructions, see printing a document.

If you encounter a problem while printing, see troubleshooting.

printing posters

tab setting

Setup • Paper Type: Automatic or Plain Paper
• Paper Size: Appropriate size
• Orientation: Appropriate orientation

Features • Poster Printing: Select this option, then select 2x2, 3x3, 
or 4x4
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banners 

• See the printer Release Notes for specific printing information.
• Use hp banner paper for best results.

1. Raise the top of the paper tray.

2. Slide out both paper guides, then remove all paper from the tray.

3. Select up to 20 sheets of banner paper. Remove and discard any 
perforated strips. 

4. Place the banner paper in the paper tray with the unattached edge of 
the paper facing the printer.

5. Slide the paper guides snugly against the paper.

6. Lower the top of the paper tray, then pull out the paper tray extension.

printing guidelines

preparing to print
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If your software program includes a banner-printing feature, follow the 
instructions provided with the software program.

1. Open the Printer Properties dialog box, then select the following settings:

2. Select any other desired print settings.

3. After you have selected the print settings, click OK.

For basic printing instructions, see printing a document.

If you encounter a problem while printing, see troubleshooting.

printing banners

tab setting

Setup • Paper Type: hp banner paper or other banner paper
• Print Quality: Normal 
• Paper Size: Banner [A4 (210 x 297 mm)] or Banner [Letter 

(8.5 x 11 in.)]
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iron-on transfers 

• When printing a document with a mirror-image, the text and pictures 
are horizontally reversed from what appears on the computer screen.

• Use hp iron-on t-shirt transfer paper for best results.

1. Raise the top of the paper tray.

2. Slide out both paper guides, then remove all paper from the tray.

3. Fan the edges of the iron-on transfer paper to separate them, then align 
the edges.

4. Place the iron-on transfer paper in the tray with the printable side down.

5. Slide the paper guides snugly against the transfer paper.

6. Lower the top of the paper tray, then pull out the paper tray extension.

printing guidelines

preparing to print
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If your software program includes an iron-on transfer-printing feature, follow 
the instructions provided with the software program.

1. Open the Printer Properties dialog box, then select the following settings:

2. Select any other desired print settings.

3. After you have selected the print settings, click OK.

For basic printing instructions, see printing a document.

If you encounter a problem while printing, see troubleshooting.

printing iron-on transfers

tab setting

Setup • Paper type: Automatic or hp iron-on t-shirt transfers
• Print Quality: Normal or Best
• Paper Size: A4 (210 x 297 mm) or Letter (8.5 x 11 in.)
• Orientation: Mirror Image
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infrared printing 

infrared printing with a laptop or notebook computer

setting up a laptop or notebook in Windows 98 and Me

If the operating system you are using is Windows 98 or Me, the computer’s 
BIOS settings may need to be reconfigured for infrared printing. Use one of 
the following methods to locate instructions for configuring the laptop or 
notebook:

• See the instructions that came with the laptop or notebook.
• Log onto the laptop manufacturer’s Website or contact its customer 

support.
• Log onto the Infrared Data Association (IrDA) website at:

 http://www.irda.org

1. Click Start > Settings > Control Panel.
The Control Panel screen appears.

2. Do one of the following:
• Double-click the Infrared icon.
• Click the Infrared icon at the end of the taskbar if it is displayed.

3. Select the Options tab.

4. Select the Enable infrared communications box.

5. Click OK.

For more information on infrared printing visit HP’s website at:
www.hp.com/support/cp1160.

http://www.hp.com/support/cp1160
http://www.irda.org
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selecting the port in Windows 98 or Me

1. Click Start > Settings > Printers to open the Printers window.

2. Right-click hp cp1160 to view the shortcut menu.

3. Select Properties.

4. Select the Details tab.

5. Select IR Local Port in the Print to the following port box.

6. Click OK.

printing in Windows 98 or Me

1. Locate the infrared lens on the laptop or notebook.
See the operating manual that came with the computer for the location 
of the infrared lens.

2. Align the computer’s infrared lens with the printer’s infrared lens.
The computer should be positioned no more than one meter (three feet) 
from the printer and within a 30-degree total angle from the printer’s 
infrared lens.

3. Remove any obstacles between the two devices.

4. Send a file to print following normal print procedures.
The infrared icon appears on the LCD panel.

If the laptop or notebook is moved out of the printer’s infrared lens range 
at any time during the printing process, the infrared icon disappears, 
and the printer stops printing. Realign the devices within 3-30 seconds, 
and the print job will resume.
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selecting the port in Windows 2000

1. Click Start > Settings > Printers to open the Printers window.

2. Right-click hp cp1160 to view the shortcut menu.

3. Select Properties.

4. Select the Ports tab.

5. Select IR Local Port in the Print to the following port box.

6. Click OK.

printing in Windows 2000

1. Locate the infrared lens on the laptop or notebook.
See the operating manual the came with your computer for the location 
of the infrared lens.

2. Align the computer’s infrared lens with the printer’s infrared lens.
The computer should be positioned no more than one meter (three feet) 
from the printer and within a 30-degree total angle from the printer’s 
infrared lens.

3. Remove any obstacles between the two devices.

4. Send a file to print following normal print procedures.
The infrared icon appears on the LCD panel.

If the laptop or notebook is moved out of the printer’s infrared lens range 
at any time during the printing process, the infrared icon disappears, 
and the printer stops printing. Realign the devices within 3-30 seconds, 
and the print job will resume.
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displaying the infrared icon on the taskbar

The infrared icon appears on the taskbar after you configure your laptop or 
notebook for infrared printing. If the icon does not appear, follow these 
instructions to activate it:

1. Click Start > Settings > Control Panel.

2. Double-click the Infrared icon.
The Infrared Monitor dialog box appears.

3. Select the Preferences tab.

4. Click the Display the Infrared Monitor icon on the taskbar box.

5. Click OK.
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infrared printing with a Palm device
1. Locate the infrared lens on the Palm device.

2. Align the Palm device’s infrared lens with the printer’s infrared lens.
The Palm device should be positioned no more than one meter (three 
feet) from the printer and within a 30-degree total angle from the 
printer’s infrared lens.

3. Remove any obstacles between the Palm device and printer.

4. Do one of the following:
• Use the Beam command to print a single calendar appointment, one 

or more business cards, to-do list items, or memos.
• Use the Print command to send one or more items such as calendar 

appointments, email messages, phone lists, or to-do lists to the printer. 
The infrared light projects a solid beam on the printer during the 
information transfer process. When the information transfer is complete, 
the light turns off.

Printing, rather than beaming, requires a printing program which 
enhances the appearance of your printed information. Follow the 
specific procedures provided with the printing program when printing. 
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infrared printing with a Windows CE device
1. Locate the infrared lens on the Windows CE device.

See the device’s operating manual for the location of the infrared lens.

2. Align the infrared lens on the Windows CE device with the printer’s 
infrared lens.
The Windows CE device should be positioned no more than one meter 
(three feet) from the printer and within a 30-degree total angle from the 
printer’s infrared lens.

3. Remove any obstacles between the CE device and the printer.

4. Open the file you want to print. 

5. Open the Printer Properties dialog box.

6. Choose PCL inkjet in the Printer box.

7. Select IRDA in the Port box.

8. Click OK. 
The infrared icon projects a solid beam on the printer during the 
information transfer process. When information transfer is complete, the 
icon disappears.
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maintenance
• replacing ink cartridges

• replacement alternatives

• maintaining ink cartridges

• ink cartridge selection numbers

• replacing printheads

• cleaning printheads

• printhead selection numbers

• maintaining the printer body

• toolbox
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replacing ink cartridges 

LCD panel messages
When it is time to replace an ink cartridge, one of the following messages 
appears on the LCD panel (ink levels may vary):

For ink cartridge replacement alternatives, see replacement alternatives.

For information on HP’s ink cartridge recycling program, see hp inkjet 
product recovery program.
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selection numbers

When replacing ink cartridges and printheads, purchase ink 
cartridges and printheads with selection no. 14.

For more information, see ink cartridge selection numbers.

Caution! To avoid damaging the printer, remove an ink cartridge or 
a printhead only when a replacement is available. If an ink cartridge 
or a printhead is removed without being replaced:

• Close the print carriage and the printer doors.
• Replace the ink cartridge or printhead within 24 hours.
• Never remove an ink cartridge and a printhead at the same time.
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replacing an ink cartridge
To replace an ink cartridge:

1. Verify that the top of the paper tray is down.

2. Verify that the printer is turned on.

3. Open the printer’s front door.
The carriage moves to the center of the printer.

4. Press the Release button on the ink cartridge to be replaced, lift the ink 
cartridge out of the carriage, then discard it.

1. paper tray (in down position) 
2. open front door 
3. press release button 
4. lift out cartridge

Warning! Keep both new and used ink cartridges out of the 
reach of children.

�

�

�

�
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5. Remove the replacement ink cartridge from its packaging, then carefully 
pull the tab to remove the foil seal from the bottom of the cartridge.

Caution! Do not touch the ink cartridge copper contacts or the surfaces 
around the ink wells. Touching these parts may adversely affect the 
performance of the ink cartridge.

1. black cartridge 
2. color cartridge 
3. foil seal–remove only the foil seal
4. copper contacts–do not touch or remove the copper contacts 

ink removal

Follow these guidelines if you get ink on the following:
Skin: Wash with a gritty soap.
White fabric: Wash with chlorine bleach and cold water.
Color fabric: Wash with sudsy ammonia and cold water.

Warm or hot water may set the ink color into the fabric.

�

�

�

�
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6. Insert the ink cartridge firmly into the print carriage, then press it down 
until it snaps into place.

7. Close the front door. 

If the LCD panel continues to show a problem with the ink cartridge, remove 
the cartridge from the printer, then reinstall it. Also verify the correct selection 
number.

If you continue to have a problem, see contacting hp services and support.
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replacement alternatives

hp supplies
To get the best performance from your printer, HP recommends using only 
genuine HP supplies. For the correct selection numbers, see ink cartridge 
selection numbers.

Caution! Damage that results from modifying or refilling HP ink 
cartridges or the use of non-HP ink is specifically excluded from the 
warranty coverage for the printer and printer supplies.

non-hp ink cartridges
The Ink Level Gauge may not work properly with a non-HP ink cartridge. If 
you choose to print with a non-HP ink cartridge, you may not know when the 
cartridge is running low or empty. Printing with an empty ink cartridge may 
seriously damage the printheads.

Any damage resulting from the use of a non-HP ink cartridge is not the 
responsibility of Hewlett-Packard.

refilled ink cartridges
To install a refilled HP ink cartridge, you must override the Ink Level Gauge. 
See the caution statement in overriding the ink level gauge.
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overriding the ink level gauge
Overriding the Ink Level Gauge disables the printer’s ink level tracking 
feature.

Caution! If you use the override sequence described below, you will 
disable the Ink Level Gauge for your ink cartridge. If you choose to 
continue printing with an ink cartridge that has had its Ink Level 
Gauge disabled, you may not know when the cartridge is running 
low or empty. Printing with an empty cartridge may seriously 
damage your printheads. Damage that results from continued use of 
an ink cartridge with a disabled Ink Level Gauge is not the 
responsibility of HP. Damage that results from the use of non-HP ink 
is not the responsibility of HP.

The Ink Level Gauge automatically resets when a different ink cartridge is 
installed in the printer.

Overriding the Ink Level Gauge does not affect ink cartridge expiration 
dates. The printer cannot use an expired ink cartridge.
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Follow these steps to override the Ink Level Gauge:

if you installed a black ink cartridge
1. Press and hold down the Power button.

2. While holding down the Power button:
• Press the Cancel button twelve times
• Press the Resume button once.

3. Release the Power button.

if you installed a tri-color ink cartridge
1. Press and hold down the Power button.

2. While holding down the Power button:
• Press the Cancel button twelve times.
• Press the Resume button three times.

3. Release the Power button.

Always install an ink cartridge before performing an Ink Level Gauge 
override.
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maintaining ink cartridges
The following tips will help maintain HP ink cartridges and ensure consistent 
print quality:

• Keep all ink cartridges in the original sealed packages until they are 
needed. Ink cartridges should be stored at room temperature 
(60–78 degrees F or 15.6–26.6 degrees C).

• If the protective tape has been removed from the ink cartridge, do not 
attempt to reattach it. Reattaching the tape may damage the ink 
cartridge. Place the cartridge in an airtight, plastic container.

• Once ink cartridges are installed in the print carriage, do not remove 
them.

Caution! Always use the Power button to turn off the printer. Do not 
unplug the printer until printing is complete, the print carriage returns to 
the home position on the right side of the printer, and the printer has 
been turned off. Ink cartridges dry out if not stored in the home position.
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expired ink cartridges
To protect against deteriorated print quality and damage to your printer, the 
printer monitors the age of the ink cartridges. When a cartridge has reached 
its expiration date, the cartridge stops working and the printer ceases to 
operate until the cartridge is replaced. If installed prior to the “Must Install 
Before” date (see the back of the ink cartridge packaging) hp no. 14 ink 
cartridges will expire 18 months after installed in the printer. If installed after 
the “Must Install Before” date, the cartridges will expire in less than 18 
months. The expiration period is the maximum time in which an ink cartridge 
can be used, it is not a warranty period.

It is recommended that you do not stockpile ink cartridges.

To see the expiration date for an installed ink cartridge, print a diagnostic 
page.

Caution! To avoid damaging the printer, remove an ink cartridge or 
a printhead only when a replacement is available. If an ink cartridge 
or a printhead is removed without being replaced:

• Close the print carriage and the printer doors.
• Replace the ink cartridge or printhead within 24 hours.
• Never remove an ink cartridge and a printhead at the same time.
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ink cartridge selection numbers

When replacing ink cartridges and printheads, purchase ink 
cartridges and printheads with selection no. 14.

selection 
no.

selection 
color

product 
number

product name

14 Black C5011A hp 14 black ink 
cartridge

14 Tri-color C5010A hp 14 tri-color ink 
cartridge
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replacing printheads 

LCD panel messages
When a printhead fails, one of the following messages appears on the LCD 
panel (ink levels may vary):

The printer will continue to print; however the failed printhead may affect 
print quality and speed. If several printheads fail, the printer may stop 
printing.

If you notice poor print quality, but a printhead icon is not flashing, print a 
Diagnostic Page to gauge printhead performance. 

For instructions on printing a Diagnostic Page, see diagnostic page.



92

selection numbers

When replacing ink cartridges and printheads, purchase ink cartridges 
and printheads with selection no. 14.

For more information, see printhead selection numbers.

Caution! To avoid damaging the printer, remove an ink cartridge or 
a printhead only when a replacement is available. If an ink cartridge 
or a printhead is removed without being replaced:

• Close the print carriage and the printer doors.
• Replace the ink cartridge or printhead within 24 hours.
• Never remove an ink cartridge and a printhead at the same time.
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replacing a printhead

To replace a printhead:

1. Verify that the printer is turned on.

2. Open the printer doors.
The print carriage moves to the center of the printer.

3. Lift the print carriage latch, then open the print carriage.

1. latch

�
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4. Grip the handle of the failed printhead, then lift the printhead out of the 
print carriage.

ink removal

Follow these guidelines if you get ink on the following:
Skin: Wash with a gritty soap.
White fabric: Wash with chlorine bleach and cold water.
Color fabric: Wash with sudsy ammonia and cold water.

Warm or hot water may set the ink color into the fabric.
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5. Unwrap the new printhead, then remove the protective plastic tape.

1. ink nozzles 
2. plastic tape–remove only the plastic tape 
3. copper contacts–do not touch or remove the copper contacts
4. do not touch the printhead tower

6. Holding the printhead handle, gently push the printhead into place in the 
print carriage.

Warning! Keep both new and used printheads out of the reach 
of children.

�

�

�

�
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7. Close the print carriage, then press the print carriage latch into position 
until it clicks.

1. print carriage latch 
2. verify that the loops catch the hooks

8. Close the top printer door, then the front door.
The printer aligns the printheads.

9. Wait for a calibration page to print.

�

�
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cleaning printheads
If your printed pages are missing lines or dots, or if they contain ink streaks, 
the printheads may need to be cleaned. 

During the cleaning process, the printer also verifies the health of each 
printhead. If a printhead has failed, its icon flashes on the LCD panel.

Follow these steps to clean the printheads:

1. Open the Toolbox.

2. Click Print a Diagnostic Page.
A Diagnostic Page prints.

3. If the Diagnostic Page indicates a problem with a printhead, then 
proceed to step 4.
For instructions on using a Diagnostic Page, see diagnostic page.

4. Click Clean the Printheads.

5. Follow the onscreen instructions.

Caution! Only clean printheads when it is necessary. Unnecessary 
cleaning wastes ink.

For a description of the Toolbox, see toolbox.

If you have questions about the cleaning feature, point to the Clean the 
Printheads option and click the right mouse button to display the What’s 
This? dialog box. Click What’s This? for more information.
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printhead selection numbers

When replacing ink cartridges and printheads, purchase ink
cartridges and printheads with selection no. 14.

selection 
no.

selection 
color

product 
number

product name

14 Black C4920A hp 14 black printhead

14 Cyan C4921A hp 14 cyan printhead

14 Magenta C4922A hp 14 magenta 
printhead

14 Yellow C4923A hp 14 yellow printhead
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maintaining the printer body 

printer case exterior
Follow these guidelines when cleaning the outside of the printer:

• Use water only. Do not use household cleaners or detergents.
• Use a soft damp cloth to remove dust, smudges, stains, and spilled ink 

from the printer case exterior.

printer interior

Caution! Do not clean the printer’s interior. Keep all liquids away from 
the interior. 

If streaks appear on printouts, see cleaning printheads.

print carriage rod
Do not lubricate the rod on which the print carriage moves. It is normal to 
hear noise as the carriage moves back and forth on the rod when the printer 
is new. 

handling and storage
Handle and store the printer in an upright, level position for maximum 
performance and reliability.
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toolbox 
The Toolbox contains a number of useful tools to calibrate the printer, clean 
the printheads, print a test page, and print a diagnostic page.

displaying the toolbox
Use one of the following methods to open the Toolbox:

• Click Start > Programs > Hewlett-Packard > hp cp1160 > Toolbox.
• Right-click the taskbar icon, then select Open Toolbox.

For instructions for using the taskbar icon, see changing default 
printer properties.

• Select the Services tab in the Printer Properties box, then click Open 
the hp toolbox.
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toolbox navigation
The Toolbox has several tabs. Each tab displays a certain group of tools.

Click a tab to view its contents.

1. For a description of a specific tab, see device services, estimated ink 
level, configuration, or warning information tab.

Depending on how your printer was installed, the Toolbox may not display 
all the tabs shown above.

To find more information about options on each tab screen, point to an 
option and click the right mouse button to display the What’s This? dialog 
box. Click What’s This? to view more information about the selected 
option.

�
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toolbox tabs

device services

The Device Services tab displays the following tools:

1. Open the User’s Guide: View onscreen User’s Guide.

2. Calibrate the Device: Calibrates the printer and aligns the printheads.

3. Calibrate Color: Adjusts color to correct problems with tint.

4. Clean the Printheads: Cleans the printheads.

5. Print a Test Page: Verifies that the printer and computer are 
communicating.

6. Print a Diagnostic Page: Prints a Diagnostic Page. For instructions 
about using a Diagnostic Page, see diagnostic page.

�

�

�

�

�

�
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estimated ink level

Depending on how your printer was installed, the Estimated Ink Level tab may 
not be available in the Toolbox.

The Estimated Ink Level tab displays the following:

• Approximate ink level for each ink cartridge
• Access button to HP online ordering

Depending on how the printer is connected to your computer, the ink levels 
may not display here. 

Print a Diagnostic Page to see a more precise ink level for each ink cartridge.

For instructions on printing a Diagnostic Page, see diagnostic page.

The Estimated Ink Level feature does not function with refilled ink 
cartridges.
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configuration

Depending on how your printer was installed, the Configuration tab may not 
be available in the Toolbox.

The Configuration tab displays the following settings:

1. Automatic Two-Sided Print Module: Activate or deactivate the 
duplexer.

2. Messages: Activate or set system messages.

�

�
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warning messages indicators

warning information tab

Depending on the communication capability between the printer and the 
computer, a fourth tab may appear in the Toolbox when the printer is in a 
warning condition.

The Warning Information tab displays:

• A warning message describing the condition
• Access button to HP online ordering
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taskbar icon

The taskbar icon appears at the end of the taskbar. The color and 
appearance of the icon indicate the status of warning messages.

• When the taskbar icon is blinking and outlined in yellow, unread 
warning messages have been issued.

• When the taskbar icon is no longer blinking but is outlined in yellow, 
previously read warning messages are pending. 

• When the taskbar icon is no longer outlined in yellow, warning issues 
are resolved.
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troubleshooting
Use one of the following methods to find a solution to a problem:

To interpret an error message, see LCD panel error 
messages

To point and click on a printer part, see printer 
diagram

To print and interpret a Diagnostic Page, see 
diagnostic page.

If you observe a specific problem with the printer, 
click the topic below which best describes the 
problem:

• printer is not printing

• problems with printouts

• printer is too slow

• two-sided printing problems

• communication error

• infrared printing problems

• printer hardware problems

��
�
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LCD panel error messages
The alert icon always flashes in conjunction with at least one other icon. From 
the menu below, click the icon that is flashing with the alert icon.

ink cartridge icons are flashing

paper icons are flashing

printhead icons are flashing

door icons are flashings

communication icon is flashing

If the alert icon is displayed but not flashing, see contacting hp services and 
support.

(ink levels may vary)

black tri-color

paper tray two-sided 
printing

banner

cyan black magenta yellow

top door front door

communication
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ink cartridge icons are flashing
Click the LCD panel display to view the appropriate problem solution (ink 
levels may vary).

Out of Black Ink Out of Tri-color Ink Black Ink Expired

Tri-color Ink Expired Print Carriage Stall Ink Delivery System Error
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printhead icons are flashing
Click the LCD panel display to view the appropriate problem solution (ink 
levels may vary).

Cyan Printhead Failed Black Printhead Failed Magenta Printhead Failed

Yellow Printhead Failed Ink Delivery System Error
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printer diagram
Click the printer part with which you are having a problem.

1 paper tray

2 infrared printer feature

3 power button

4 duplexer

5 ink delivery system

�
�

� �

�
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ink delivery system
From the list below, click the printer part with which you having a problem.

1 ink cartridges

2 print carriage

3 printheads

� � �
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diagnostic page
The Diagnostic Page provides detailed information concerning the status of 
the ink cartridges and printheads.

Print a Diagnostic Page when you:

• Encounter print quality problems
• Want to view information about printheads and ink cartridges
• Want to check ink levels
• Want to see the printer serial number
• Plan to call HP Services and Support (if possible)
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printing a diagnostic page
Follow these steps to print a Diagnostic Page:

from the printer driver

1. Open the Toolbox.

2. Click Print a Diagnostic Page.
The page prints.

or from the printer

1. Press and hold down the Power button.

2. While holding down the Power button, press the Cancel button once.

3. Release the Power button.
The page prints.
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ink cartridge information
The Diagnostic Page provides the following information about the ink 
cartridges:

1. Ink Level: The precise ink level for each cartridge.

2. Status: 
• OK = Cartridge is working.
• Replace Soon = Cartridge will expire soon, is low on ink, or very 

low on ink.
• IDS Failure - Call HP= Call HP Services and Support.

3. Expiration: The expiration date for each cartridge. The cartridge 
must be replaced by this date for the printer to continue operating.

4. Product Number and Selection Number: See ink cartridge selection 
numbers.

�
�

�
�
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printhead information

1. Color Block: If any block is not solid, see print quality.

2. Color: 
• C = Cyan
• K = Black
• M = Magenta
• Y = Yellow

3. Status: 
• OK = Printhead is working.
• Replace Now = Printer may not work with printhead.
• Disabled = Printhead is temporarily out of service. See disabled 

printheads.
• IDS Failure - Call HP = Call HP Services and Support.

4. Installation Date: Week each printhead was installed.

5. Product Number and Selection Number: See printhead selection 
numbers.

6. Printhead Alignment: If any of the bars are not aligned, see 
printhead alignment.

�
�
�
�
�
�
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print quality

Follow these steps if one or more of the Color Blocks is not solid:

1. Load clean, plain white paper in the paper tray.
Using paper with printing on either side will undermine the cleaning 
process.

2. Open the Toolbox.

3. Click Clean the Printheads, then follow the onscreen instructions.
If one of the printheads has failed, the printhead icon flashes on the LCD 
panel. Replace the printhead. To reset the LCD panel, turn the printer off, 
then turn it back on.

For instructions on replacing a printhead, see replacing printheads.

disabled printheads

When a printhead has failed and shows a status of Replace Now, one or 
more of the other printheads may have a status of Disabled. The Disabled 
status is temporary.

Once the failed printhead is replaced, the disabled printheads will operate 
and have a status of OK.

Do not replace a printhead with a status of Disabled. Only replace a 
printhead with the status of Replace Now.
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printhead alignment

Follow these steps if any of the bars on the Diagnostic Page are not aligned:

1. Load clean, white plain paper in the paper tray.
Using paper with printing on either side will undermine the calibration 
process.

2. Open the Toolbox.

3. Click Calibrate the Printer.
Follow the onscreen instructions to align the printheads.

4. Reprint the Diagnostic Page.
If the alignment is not corrected, calibrate the printer again. If the 
problem continues, call HP Services and Support.
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printer is not printing
Verify the following:

• The printer is connected to the power source. 
• The cable connections are secure.
• The printer is turned on.
• The media is correctly placed in the paper tray.
• The printer’s top cover is closed.
• The duplexer or Rear Access Door is attached.
• If the Power light is blinking, the printer is in the process of 

printing. 
• If the Resume light is blinking, press the Resume button.

Select the topic that best describes the problem:

• ink cartridge needs to be replaced

• printheads need to be replaced

• paper problems

• ink delivery system not working

• USB problems

If none of the above solves the problem, then uninstall and reinstall the printer 
software.

For instructions on uninstalling and reinstalling the printer software, see 
uninstall and reinstall instructions.
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ink cartridge needs to be replaced
If an ink cartridge expires or runs out of ink, it needs to be replaced. 

For instructions on replacing an ink cartridge, see replacing ink cartridges.

printheads need to be replaced
If multiple printheads fail, the printer may stop printing. 

For instructions on replacing printheads, see replacing printheads.
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paper problems
If you see this display on the LCD panel, then click the appropriate topic 
below:

• paper jam

• out of paper

Otherwise, click the topic below that best describes the problem:

• printer ejects the paper

• blank pages are printing
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paper jam

Occasionally paper jams in the printer. When this happens the following 
display appears on the LCD panel.

Follow each of the following steps until the paper jam is cleared.

1. Press the Resume button.

2. Remove the paper from the paper tray.

3. Detach the removable paper tray(s), remove any paper stuck in the 
paper tray slot, replace the tray(s), then press the Resume button.

4. Open the printer front door, remove any visible paper, close the door, 
then press the Resume button.

5. Remove the duplexer, then remove any visible paper jam in the printer. 

6. Open the duplexer rear access door, then remove any paper from the 
duplexer. 

7. Re-attach the duplexer, then press the Resume button.
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out of paper

When the printer either runs out of paper or cannot locate paper, the 
following display appears on the LCD panel:

if the paper tray is loaded
1. Adjust the length guide so that the paper stack touches the back of 

the paper tray

2. Press the Resume button.

if the paper tray is empty
1. Load paper in the tray.

2. Press the Resume button.

For instructions on loading the paper tray, see printing, then select the 
particular media.
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printer ejects the paper

The printer may have been placed in direct sunlight which can affect the 
Automatic Paper-Type Sensor. Move the printer away from direct sunlight.

blank pages are printing

The printer may process pages containing no text or images if a facsimile 
(fax) is being printed.

Follow these steps to save a fax file in graphic format:

1. Save the fax in a graphic format with a TIF file name extension.

2. Copy and insert the graphic in a word processing document. 

3. Save the document.

4. Print the document in the word processing program.
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ink delivery system not working
• print carriage stalls

• ink delivery system error occurs
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print carriage stalls

When the print carriage stalls, the following display appears on the LCD 
panel.

Follow these steps to fix a carriage stall.

1. Press the Resume button.

2. If the carriage is still stalled, press the Cancel button.

3. If the carriage is still stalled, open the front door, then open the top door.

4. Verify that the ink cartridges are installed correctly. If a cartridge is not 
securely seated in the print carriage, remove it, then reinstall it.
For instructions on installing print cartridges, see replacing ink 
cartridges.

5. Remove any paper you see in the printer.

6. Close the top door, then close the front door.

7. If the printer still does not print, then press the Cancel button, turn off the 
printer, turn it back on, then resend your document.



127

ink delivery system error occurs

When the printer encounters a major error with the ink delivery system, the 
following display appears on the LCD panel.

Call HP for help.

For information on contacting HP, see contacting hp services and support.
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USB problems
• the error message “there was an error writing to lpt1” appears

• the error message “there was an error writing to <name of usb 
port>” appears

• conflicting USB cable connections
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the error message “there was an error writing to lpt1” appears

The USB cable may not have been attached before installing the software. 
Uninstall the software, then reinstall it.

Follow these steps to uninstall then reinstall the printer software.

1. Disconnect the USB cable from the printer. 

2. Follow one of these methods to uninstall the software:
• Select Start > Programs > Hewlett-Packard > hp cp1160 > uninstaller.
• Select Start > Settings > Control Panel, then double-click Add/Remove 

Programs. Select the hp cp1160 software, then select the option to 
remove the hp cp1160 software from your PC.

3. Connect the USB cable from the computer to the printer.
The USB installation screen appears.

4. Insert the CD-ROM that came with the printer into your computer’s CD-
ROM drive.

5. Follow the onscreen instructions. 
See the Reference Guide for more information.
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the error message “there was an error writing to <name of usb port>” 
appears

The printer may not be receiving correct data from another USB device or the 
hub. Connect the printer directly to the USB port on the computer.

conflicting USB cable connections

A printing conflict may arise when the printer and several USB devices are 
attached to a hub. There are two methods for solving the conflict:

• Attach the printer’s USB cable directly to the computer.
• If the printer is attached to a hub, do not use other USB devices 

attached to the hub while printing.
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uninstall and reinstall instructions
Follow these steps to uninstall then reinstall the printer software on your 
computer:

1. Follow one of these methods to uninstall the software:
• Select Start > Programs > Hewlett-Packard > hp cp1160 > uninstaller.
• Select Start > Settings > Control Panel, then double-click Add/Remove 

Programs. Select the hp cp1160 software, then select the option to 
remove the hp cp1160 software from your PC.

2. Close all virus protection programs or other software running on the 
computer.

3. Insert the CD-ROM that came with the printer into your computer’s 
CD-ROM drive.

4. Follow the onscreen installation instructions.

downloaded software

Follow these steps to install software if you have downloaded printer software 
from the Web:

1. Locate the directory where the file was downloaded.

2. Double-click the filename to expand the file.

3. Select Start > Run.

4. Click the Browse button, then locate the Setup.exe file for the printer 
software.

5. Click OK.

6. Follow the onscreen installation instructions.
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problems with printouts 
Click the topic below that best describes the problem:

• print quality is poor

• document is printed off-center or at an angle

• parts of the document are missing or printed in the wrong place

• printout does not reflect new print settings

• photos are not printing correctly

• banner does not print correctly
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print quality is poor
Click the topic below that best describes the problem:

• color is tinted

• text and images are misaligned

If the print quality of a printout is not as good as you expected, see the 
following:

• problems with the automatic paper-type sensor

• a printhead may be failing
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color is tinted

If the color on your printouts is tinted incorrectly, then calibrate the printer’s 
color.

Follow these steps to calibrate the printer’s color:

1. Open the Toolbox.

2. Click Calibrate Color.

3. Follow the onscreen instructions.

For a description of the Toolbox, see toolbox.

text and images are misaligned

If the text and images on your printouts are misaligned, then calibrate the 
printer to align the printheads.

Follow these steps to calibrate the printer:

1. Open the Toolbox.

2. Click Calibrate the Device.

3. Follow the onscreen instructions.

For a description of the Toolbox, see toolbox.
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problems with the automatic paper-type sensor

The Automatic Paper-Type Sensor scans each sheet of paper before printing 
and determines the best print setting. Several factors can affect the Automatic 
Paper-Type Sensor and reduce print quality.

check the paper
If you are using the Automatic Paper-Type Sensor, verify that the paper is 
not wrinkled or scratched. Replace the paper if it is damaged.

turn off the automatic paper sensor
If the print quality does not improve, turn off the Automatic Paper-Type 
Sensor.

For instructions on turning off the Automatic Paper-Type Sensor, see 
turning off the automatic paper-type sensor.

a printhead may be failing

A failing, but usable, printhead may cause poor print quality. Print a 
Diagnostic Page to see if a printhead needs to be replaced.

For instructions on printing a Diagnostic Page, see diagnostic page.
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document is printed off-center or at an angle
1. Verify that the paper is correctly placed in the paper tray.

2. Verify that the paper guides fit snugly against the paper.

3. Reprint the document.

parts of the document are missing or printed in the wrong 
place
Follow the basic printing instructions and verify the following options:

For basic printing instructions, see printing a document.

printout does not reflect new print settings 
The printer’s default settings may differ from the software application’s print 
settings. Select the appropriate print settings within the software application.

tab setting

Setup • Paper Size: Verify the appropriate paper size and 
margins

• Scale to Fit: Select to scale text and graphics to fit on the 
paper

• Orientation: Verify the appropriate orientation

Features • Poster Printing: Deselect this option if not printing a 
poster
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photos are not printing correctly 

check the paper tray

1. Verify that the photo media is placed in the paper tray with the print side 
down.

2. Slide the paper forward until it stops.

3. Slide the paper guides snugly against the paper, then push in the tray.

check the printer properties

Follow the basic printing instructions and verify the following options:

For basic printing instructions, see printing a document.

tab setting

Setup • Paper Type: an hp photo paper 
• Paper Size: Appropriate size
• Print Quality: Best
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banner does not print correctly
When the printer encounters a problem printing a banner, the following 
display appears on the LCD panel.

check the paper tray
• Unfold and refold the paper when several sheets feed into the printer 

at once.
• Confirm that the unattached edge of the banner paper stack is facing 

the printer.
• Verify that the correct paper for banner printing is used.

check the printer properties

Follow the basic printing instructions and verify the following setting:

For basic printing instructions, see printing a document.

tab setting

Setup • Paper Size: Appropriate size
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check the software
• Verify that the software application you are using prints banners. Not 

all software applications print banners.
• If gaps appear at the ends of the sheets, verify that the printer 

software is operating correctly.
• Click Start > Programs > Hewlett-Packard > hp cp1160 > Release 

Notes to view Release Notes for known software issues.
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printer is too slow 
Several variables can slow the printer’s performance. Click the topic below 
that best describes the printer’s performance:

• multiple software applications are open

• complex documents, graphics, or photographs are printing

• automatic paper type option is enabled

• two-sided documents are printing

If none of the above topics describes the printer’s performance, then review 
the following:

• printer software is outdated

• computer does not meet system requirements

• a printhead may be failing
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multiple software applications are open
If too many software applications are open, the printer cannot print at its 
normal speed. 

Close all unnecessary software applications, then print the document again.
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complex documents, graphics, or photographs are printing
Documents containing graphics or photographs print slower than text 
documents. To print faster:

Open the Printer Properties dialog box, then select one of the following 
settings:

For a description of the Printer Properties dialog box, see printer properties.

tab setting

Setup Photo Paper Printing: Select PhotoREt.

Color Low Memory Mode: Select this option.
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automatic paper type option is enabled
When the automatic option is enabled, it takes a few seconds for the printer 
to scan the first page of the print job to determine the appropriate paper type. 

To increase the print speed, turn off the Automatic Paper-Type Sensor.

For instructions on turning off the Automatic Paper-Type Sensor, see turning 
off the automatic paper-type sensor.

two-sided documents are printing
Print two-sided documents takes more time than printing single-sided 
documents.

printer software is outdated
An outdated driver may be installed.

Log onto HP’s Website to download the most recent software updates for the 
printer.

For information about HP’s Website, see hp e-support.
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computer does not meet system requirements
1. Verify the computer’s RAM and processor speed. 

For more information, see system requirements.

2. Increase space on the hard drive. 
If your computer has less than 100 MB available on the hard drive, the 
printer processing time will be longer.

a printhead may be failing
A failing, but usable, printhead may slow printer performance. Print a 
Diagnostic Page to see if your printer has a failing printhead.

For instructions on printing a Diagnostic Page, see diagnostic page.

If you continue to have problems with the printer, then see contacting hp 
services and support.
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two-sided printing problems
Click the topic below if you see this display on the LCD panel:

• paper jam occurs inside the automatic two-sided printing module

Select the topic that best describes the problem with the printer software:

• option for two-sided printing cannot be selected

• paper size changes when the two-sided printing option is selected

Select the topic that best describes the problem with a printout:

• binding margin is in the wrong place

• only one side of the page prints when the two-sided printing option 
is selected

If the duplexer is not attached to the printer, click below to see instructions for 
manual two-sided printing:

• manual two-sided printing
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paper jam occurs inside the automatic two-sided printing 
module
1. Remove the paper from the paper tray.

2. Press the Resume button on the front of the printer.
Proceed to step 3 if the paper jam is not cleared.

3. Turn off the printer.

4. Press the buttons on the left and right sides of the duplexer, then remove 
the duplexer from the printer.

5. Remove any paper jam in the printer.
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6. Press the button on top of the duplexer, then lower the access door.

7. Remove any paper from the duplexer, then close the access door.

8. Push the duplexer into the printer until it snaps into place.

9. Turn on the printer, then reprint the document.
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option for two-sided printing cannot be selected
An unsupported paper type or size may be selected in the Setup tab.

On the Setup tab, verify that a paper type and size supported by the duplexer 
is selected. Supported media types include:

• hp plain paper
• hp bright white inkjet paper
• hp premium inkjet heavyweight paper
• hp felt-textured greeting card paper
• hp professional brochure paper, glossy or matte
• hp photo quality inkjet paper, semi-gloss or matte

For supported media sizes, see media size.

For a description of the Printer Properties dialog box, see printer properties.
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paper size changes when the two-sided printing option is 
selected
The paper size selected in the Setup tab is not supported by the duplexer.

On the Setup tab in the Printer Properties dialog box, verify that a paper size 
supported by the duplexer is selected.

For supported media sizes, see media size.

For a description of the Printer Properties dialog box, see printer properties.

binding margin is in the wrong place
You may have chosen an incorrect paper orientation.

On the Features tab of the Printer Properties dialog box, verify that:

• Book is selected for binding along the side
• Tablet is selected for binding along the top

1. book 
2. tablet

For a description of the Printer Properties dialog box, see printer properties.
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only one side of the page prints when the two-sided printing 
option is selected
Use the following solutions:

• Print the document using the manual two-sided printing feature.
• Use a media type supported by the duplexer.
• Use a media size supported by the duplexer.
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communication error
Select the topic that best describes the problem:

• local connection

• network connection

When there is a communication problem, the following display appears on 
the LCD panel.
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local connection
Follow these steps if the printer encounters a communication problem over a 
local connection:

1. Verify that all cables are firmly attached to the printer and the computer.
• If you are not using a USB connection, verify that the parallel cable 

adapter is firmly attached to the printer. Verify that the parallel 
adapter is firmly attached to the parallel adapter.

• If you are using a USB connection, verify that the USB cable is firmly 
attached to the printer and the computer.

2. Press the Cancel button to cancel the print job.

3. Resend your document.
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network connection
Follow these steps if the printer encounters a communication problem over a 
network connection:

1. Press the Power button to turn the printer off.

2. Press the Power button to turn the printer back on.
• If the communication error display does not reappear on the LCD 

panel, then resend your document.
• If the communication error display does appear on the display then 

there may be a problem with the LIO module. Check the module or 
contact your network administrator.

To see a troubleshooting guide for the printer’s networking feature:

1. Insert the CD that came with the printer in the computer’s CD-ROM drive.

2. Click Networking.

3. Select Network Troubleshooting.
Troubleshooting steps for LIO network printing connections appear.

If you continue to have problems with the printer, see contacting hp services 
and support.
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infrared printing problems 
Select the topic that best describes the problem:

• printer stopped printing

• printer is taking too long to print

• infrared icon is not displayed

• single Palm Pilot calendar appointment prints

For more information on infrared printing visit HP’s website at:
www.hp.com/support/cp1160.

http://www.hp.com/support/cp1160
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printer stopped printing
When the printer has established an infrared link with another device, the 
following display appears on the LCD panel.

When the Infrared Printing Feature encounters an interruption, the infrared 
icon disappears from the LCD panel.

If the device is moved out of the printer’s infrared lens range, and the printer 
stops printing, then realign both devices within 30 seconds and the print job 
will resume. 
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printer is taking too long to print
Position the device closer to the printer’s infrared lens, then verify the 
following:

• An infrared port is selected on the laptop or notebook. 
• The device and the printer are correctly aligned.
• The device is IrDA-compliant.
• Look for an IrDA symbol or see the device’s user guide for 

information.
• There is no bright light shining directly into either devices’ infrared 

lens.
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infrared icon is not displayed
Perform one or more of these options:

• Follow the instructions that came with the laptop or notebook to 
configure infrared printing.

• Log onto the laptop or notebook manufacturer’s Website or contact 
the manufacturer’s support telephone number.

• Log onto the Infrared Data Association (IrDA) website at:
http://www.irda.org.

• Download the infrared driver from the Microsoft Windows 98/2000 
software CD or from the Microsoft Website at: 
http://www.microsoft.com.

http://www.irda.org
http://www.microsoft.com
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single Palm Pilot calendar appointment prints
The Palm Pilot may not have an enhanced printing application installed. 
Install an enhanced printing application to print more than one calendar 
appointment at a time. 

For a full description of the infrared printing feature, see infrared printing.

If you continue to have problems with the printer, see contacting hp services 
and support.

An enhanced printing application may not be available in your region. 
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printer hardware problems
Click the topic below that best describes the problem:

• printer door time out

• printer does not turn on
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printer door time out
In order to protect the ink delivery system, the printer doors can remain open 
for only 15 minutes. After 15 minutes, the print carriage goes to its rest 
position and one of the following displays appears on the LCD panel.

To access the print carriage, close the doors, then reopen them.

Caution! Do not try to force the carriage out of its rest position. It will 
damage the printer.
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printer does not turn on
Follow these steps when the power cord and cable are connected to the 
printer, but the printer does not turn on:

1. Disconnect the power cord from the electrical outlet.

2. Wait about 10 seconds.

3. Reconnect the power cord to the electrical outlet.

4. Press the Power button to turn the printer on.
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hp services and support
• contacting hp services and support

• hp printer and software limited warranty statement

• hp inkjet printhead and ink cartridge product warranty information



163

contacting hp services and support
HP Services and Support provides expert advice on using your HP printer or 
solving problems with your printer.

support process
HP support process works most effectively if you look for help in the following 
order:

1. Use the onscreen User’s Guide. 

2. Access HP e-support.
Use your Internet connection any time of the day to:

• Check HP's Web support pages for product help
• Read the HP user community forum messages or post a question
• Send HP an email
For more information, see hp e-support.

3. Contact HP support by phone during hours of operation.
For more information, see hp support by phone. 

Support options and availability vary by product, country/region, and 
language.
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hp e-support
HP e-support offers online support as long as you own your HP printer. Get 
instant access to support information, helpful printing tips, and the latest 
updates for your printer software (also referred to as the printer driver)—24 
hours a day, seven days a week, at no cost to you.

hp support Websites

If you have access to the Internet, you can obtain a wide variety of 
information about your printer.

Visit our Website for the latest printer software and support information at 
www.hp.com/cposupport/loc/regional.html or 
www.hp.com/support/cp1160.

www.hp.com/cposupport/loc/regional.html
http://www.hp.com/support/cp1160
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hp support email

One-to-one email gives direct answers to your questions from an HP service 
technician. Email support is a great way to ask technical questions or obtain 
an answer that is tailored to your specific need.

Enter your question on a Web form and receive an email reply. Responses 
are normally provided within 48 hours, excluding holidays. 
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hp support by phone
HP provides telephone support free of charge during the printer’s phone 
support period. (Standard phone company charges do apply.) 

free phone support period

The list below shows the phone support period for your region.

* Standard phone company charges apply.

region phone support*

North America—
Including Canada

1 year

Asia Pacific—
Including Japan

1 year

Europe 1 year

Latin America 1 year
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before placing a call

Before placing a call for help, try these other free support options:

• Onscreen User’s Guide
• Setup poster
• HP e-support

If you cannot solve the problem using these resources, call an HP service 
technician while you are in front of your computer and printer. For faster 
service, please be prepared to provide information about the steps you have 
taken to solve the problem. 

HP needs the following information to assist you:

• The printer's model number
• The printer's serial number (see diagnostic page)
• The computer’s operating system 
• The version of the printer driver (also referred to as the printer 

software) 
• Messages displayed at the time the situation occurred
• Answers to these questions:

Has this situation happened before? Can you re-create it? 
When did this happen? 
Did you add any new hardware or software around the time this 
situation began?
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support phone numbers

If you need help solving a problem, contact HP support using one of the 
phone numbers in the table below. If the phone number for your region is not 
listed, please refer to HP's Website: 
http://www.hp.com/cpso-support/guide/psd/expectations.html

for this region... use this phone number...

Africa/Middle East 41 22 780 71 11

Argentina (Buenos Aires) 11 4778 8380

Argentina (Outside Buenos Aires) 0810 555 5520

Australia 03 8877 8000

Austria 0660 6386

Belgium (Dutch) 02 626 8806

Belgium (French) 02 626 8807

Brazil, inside Greater Sao Paulo 11 3747 7799
11 4197 4998

Brazil, outside Greater Sao Paulo 0800 15 7751
0800 13 0999

Canada 905 206 4663

Chile  800 36 0999

China 010 6564 5959

Colombia 9 800 91 9477

Czech Republic 02 471 7327

Denmark 39 29 4099

Finland 0203 47 288

France 01 43 62 34 34

Germany 0180 52 58 143 (0.12 DM/30 
sec. unit or € 0.06/30 sec. unit) 

Greece 01 6189890

Hong Kong 3002 8555

Hungary 36 1 252 4505

http://www.hp.com/cpso-support/guide/psd/expectations.html 
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India 11 682 6035

Indonesia 21 350 3408

Ireland 01 662 5525

Israel 09 952 4848

Italy 02 264 10350

Japan 0570 000511

Korea (Seoul) 02 3270 0700

Korea, (outside Seoul) 080 999 0700

Malaysia 03 295 2566

Mexico (Mexico City) 5258 9922

Mexico (Outside Mexico City) 01 800 472 6684

Netherlands 0 20 606 8751

New Zealand 09 356 6640

Norway  22 11 6299

Peru 0 800 10111

Philippines 2 867 3551 

Poland 22 37 5065

Portugal 1 441 7 199

Russia, Moscow  095 923 50 01

Singapore 272 5300

Spain 902 321 123

Sweden 08 619 2170

Switzerland 0 848 80 11 11

Taiwan 2 2717 0055

Thailand 2 6614000

Turkey 1 216 579 71 71

for this region... use this phone number...
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after the free phone support period

After the free phone support period, you can receive help from HP for a fee. 
Prices are subject to change without notice. 

HP e-support is always available at no cost. For more information, see 
hp e-support.

• For calls in the United States that may last less than10 minutes, call 
(900) 555-1500. The charge is US$2.50 per minute, starting from the 
time you connect to a service technician. Charges will not exceed 
US$25.

• For calls in the United States that may last longer than ten minutes, 
call (800) 999-1148. The fee is US$25 per call, charged to your Visa 
or MasterCard.

• For calls in Canada, call (877) 621-4722.

If HP determines during the call that your printer needs to be repaired and 
the printer is covered under the limited warranty, you will not be charged for 
the phone support service.

United Kingdom 0870 842 2339
U.S. 1 (208) 323 2551

Venezuela (Caracas) 207 8488

Venezuela (Outside Caracas) 800 10 111

Vietnam 08 823 4530

for this region... use this phone number...
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obtaining hp repair
If your HP printer needs to be repaired, call HP phone support. A trained HP 
service technician will diagnose the problem and coordinate the repair 
process. 

For a list of HP support phone numbers, see support phone numbers.

HP support will direct you to the best solution, whether it is an authorized 
service provider or an HP facility. This service is free during your printer's 
limited warranty period. After the warranty period, you will be quoted a 
repair cost.

obtaining a warranty extension
If you would like to extend your warranty coverage beyond the limited 
warranty period, use one of the following options:

• Consult your reseller to get extended coverage. To find HP resellers in 
the U.S., visit HP’s service locator at www.hp.com/service_locator.

• If your reseller does not offer service contracts, call HP directly and 
ask about our HP service agreements. In the U.S. call (800) 446-
0522; in Canada call (800) 268-1221. For HP service agreements 
outside of the U.S. and Canada, contact your local HP sales office.

www.hp.com/service_locator
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hp printer and software limited warranty 
statement

A. extent of limited warranty
1. Hewlett-Packard (HP) warrants to the end-user customer that the HP 

products specified above will be free from defects in materials and 
workmanship for the duration specified above, which duration begins on 
the date of purchase by the customer. Customer is responsible for 
maintaining proof of date of purchase.

2. For software products, HP’s limited warranty applies only to a failure to 
execute programming instructions. HP does not warrant that the 
operation of any product will be uninterrupted or error free.

3. HP’s limited warranty covers only those defects which arise as a result of 
normal use of the product, and do not apply to any:
• Improper or inadequate maintenance or modification;
• Software, interfacing, media, parts, or supplies not provided or 

supported by HP; or
• Operation outside the product’s specifications.

region software printer

North America (including Canada) 90 days 1 year

Asia Pacific (including Japan) 90 days 1 year

Europe 90 days 1 year

Latin America 90 days 1 year
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4. For HP printer products, the use of a non-HP ink cartridge or a refilled ink 
cartridge does not affect either the warranty to the customer or any HP 
support contract with the customer. However, if printer failure or damage 
is attributable to the use of a non-HP or refilled ink cartridge, HP will charge 
its standard time and materials charges to service the printer for the 
particular failure or damage.

5. If HP receives, during the applicable warranty period, notice of a defect 
in any software, media, or ink cartridge covered by HP’s warranty, HP 
shall replace the defective product. If HP receives notice of a defect in 
any hardware product covered by HP’s warranty during the applicable 
warranty period, HP shall either repair or replace the defective product 
at HP’s option.

6. If HP is unable to repair or replace, as applicable, a defective product 
covered by HP’s warranty, HP shall, within a reasonable time after being 
notified of the defect, refund the purchase price of the product.

7. HP shall have no obligation to repair, replace, or refund until the 
customer returns the defective product to HP. 

8. Any replacement product may be either new or like-new, provided that it 
has functionality at least equal to that of the product being replaced.

9. HP’s limited warranty is valid in any country where the covered HP 
product is distributed by HP except for the Middle-East, Africa, 
Argentina, Brazil, Mexico, Venezuela, and France’s “Departements 
D’Outre-Mer”; for those excepted areas, the warranty is valid only in the 
country of purchase. Contracts for additional warranty services, such as 
on-site service, may be available from any authorized HP service facility 
where the product is distributed by HP or by an authorized importer.



174

B. limitations of warranty
1. TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS 

THIRD PARTY SUPPLIERS MAKE ANY OTHER WARRANTY OR 
CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH 
RESPECT TO THE HP PRODUCTS, AND SPECIFICALLY DISCLAIM THE 
IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, 
SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

C. limitations of liability
1. To the extent allowed by local law, the remedies provided in this 

Warranty Statement are the customer’s sole and exclusive remedies.

2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE 
OBLIGATIONS SPECIFICALLY SET FORTH IN THIS WARRANTY 
STATEMENT, IN NO EVENT WILL HP OR ITS THIRD PARTY SUPPLIERS 
BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, 
TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES.

D. local law
1. This Warranty Statement gives the customer specific legal rights. The 

customer may also have other rights which vary from state to state in the 
United States, from province to province in Canada, and from country to 
country elsewhere in the world.
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2. To the extent that this Warranty Statement is inconsistent with local law, 
this Warranty Statement shall be deemed modified to be consistent with 
such local law. Under such local law, certain disclaimers and limitations 
of this Warranty Statement may not apply to the customer. For example, 
some states in the United States, as well as some governments outside 
the United States (including provinces in Canada), may:
• Preclude the disclaimers and limitations in this Warranty Statement 

from limiting the statutory rights of a consumer (e.g., the United 
Kingdom);

• Otherwise restrict the ability of a manufacturer to enforce such 
disclaimers or limitations; or

• Grant the customer additional warranty rights, specify the duration of 
implied warranties which the manufacturer cannot disclaim, or not 
allow limitations on the duration of implied warranties.

3. FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW 
ZEALAND, THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO 
THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT, OR 
MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY 
RIGHTS APPLICABLE TO THE SALE OF HP PRODUCTS TO SUCH 
CUSTOMERS.
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hp inkjet printhead and ink cartridge 
product warranty information

hp inkjet products limited warranty
All HP Inkjet products are warranted to be free from defects in material and 
workmanship during the warranty period.

warranty period
The Inkjet product is warranted until the End-of-Warranty date, which is 
printed on each product. Refer to the individual product inserts for the 
location of the End-of-Warranty date.

hp inkjet supplies warranty limitations
The warranty does not cover empty or refilled products, printer expired 
products, or products that have been tampered with or misused.

install-by date
Every HP Inkjet product features an Install-by-date printed on the product’s 
box. The product must be installed by this date for the best printing results.

returning an hp inkjet product
If a problem occurs with an HP Inkjet product, contact HP Services and 
Support.

using non-hp inkjet products
If a non-HP Inkjet product is found to be the direct cause of printer failure or 
damage, HP will not cover the repair related to that non-HP product.
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hp inkjet product recovery program
Customers interested in recycling their genuine HP inkjet cartridges can 
participate in HP's empty inkjet cartridge return and recycle program. HP 
offers this program in the United States, Puerto Rico, France, Germany, and 
Singapore, more countries than any other inkjet manufacturer in the world. 
This program is provided as a free service to HP customers as an 
environmentally sound solution for these products at end-of-life. 

To participate, simply request a postage-paid return envelopes or bulk boxes 
via the web at www.hp.com/go/recycle or by calling 1-888-447-0145 (in 
the U.S. only). Customers will be asked for their name, phone number, 
address, and how many bulk boxes or envelopes they would like. Postage-
paid envelopes and/or bulk boxes will be shipped within two days.

Because HP's unique recycling processes are very sensitive to material 
contamination, we cannot take back and recycle cartridges from other 
manufacturers. The end products of the recycling process are used in the 
manufacture of new products, and HP must ensure the composition of the 
material is consistent. To do that, we recycle only HP original cartridges.

Returned cartridges are separated for purification into raw materials for use 
in other industries to manufacture new products. Examples of products made 
from recycled hp inkjet cartridge materials include automobile parts, trays 
used in microchip fabrication processes, copper wire, steel plates and the 
precious metals used in electronics. Depending on the model, HP is able to 
recycle up to 65% of the print cartridge by weight. The remaining parts that 
cannot be recycled (ink, foam & composite parts) are disposed of in an 
environmentally responsible manner.

http://www.hp.com/go/recycle


178

supplies and accessories
• supply and accessory part numbers

• paper and media part numbers

• how to order
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supply and accessory part numbers
Refer to these part numbers when ordering HP supplies and accessories:

ink cartridges

See ink cartridge selection numbers

printheads

See printhead selection numbers

interface cables

HP IEEE 1284-Compliant Parallel Interface Cable:

• 2 meter length: C2950A
• 3 meter length: C2951A

HP USB-Compliant Interface Cable: C6518A

LIO modules

hp jetdirect 250m print server/internet connector: J6042A

hp jetdirect 200m print server/internet connector: J6039A

optional 250-sheet plain paper tray

hp pt4395 250-sheet plain paper tray: C6501A

power cords

US, Canada, Brazil, Latin America, Saudi Arabia: 8120-6260

Japan: 8121-0585

UK, Singapore, Malaysia, Middle East, Hong Kong: 8120-8882

South Africa: 8120-8886

India: 8121-0564

Australia: 8120-8879

Argentina: 8120-8878

Korea: 8120-8884

Europe, Jordan, Lebanon, North Africa, Russia, Baltic republics: 8120-6262
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Thailand, Indonesia, Brazil, Caribbean, 
Latin America: 8121-0587 or T503082

China, Taiwan, Philippines: 8121-0586

Chile: 8120-8880

Denmark: 8120-8881

Israel: 8120-8883

Switzerland: 8120-8885
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paper and media part numbers
Refer to these part numbers when ordering HP paper and other media: 

hp bright white inkjet paper

A4 (210 × 297 mm), 200 sheets: C5977A
A4 (210 × 297 mm), 500 sheets: C1825A
US letter, 200 sheets: C5976A
US letter, 500 sheets: C1824A

hp premium inkjet paper

A4 (210 × 297 mm), 200 sheets: 51634Z
US letter, 200 sheets: 51634Y

hp professional brochure and flyer paper, matte

US letter, 50 sheets: C6955A

hp photo paper, two-sided, satin/glossy

Asian A4 (210 × 297 mm), 20 sheets: C6765A
European A4 (210 × 297 mm), 20 sheets: C1847A
US letter, 20 sheets: C1846A

hp premium photo paper, glossy

Asian A4 (210 × 297 mm), 15 sheets: C6043A
European A4 (210 × 297 mm), 15 sheets: C6040A
US letter, 15 sheets: C6039A

hp premium plus photo paper, glossy

Asian A4 (210 × 297 mm), 20 sheets: C6933A
European A4 (210 × 297 mm), 20 sheets: C6832A
US letter, 20 sheets: C6831A
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hp premium plus photo paper, matte

European A4 (210 × 297 mm), 20 sheets: C6951A
US letter, 20 sheets: C6950A

hp premium plus photo paper, glossy snapshot

European A4 (4 × 6 in finished size), 20 sheets: C6945A
US letter (4 × 6 in finished size), 20 sheets: C6944A

hp premium inkjet transparency film

A4 (210 × 297 mm), 20 sheets: C3832A
A4 (210 × 297 mm), 50 sheets: C3835A
US letter, 20 sheets: C3828A
US letter, 50 sheets: C3834A

hp premium inkjet rapid-dry transparencies

A4 (210 × 297 mm), 50 sheets: C6053A
US letter, 50 sheets: C6051A

hp banner paper

A4 (210 × 297 mm), 100 sheets: C1821A
US letter, 100 sheets: C1820A

hp matte greeting cards, white/quarter-fold

A4 (210 × 297 mm), 20 sheets, 20 envelopes: C6042A
US letter, 20 sheets, 20 envelopes: C1812A

hp felt-textured greeting cards, ivory/half-fold

US letter, 20 sheets, 20 envelopes: C6828A

hp iron-on t-shirt transfers

Asian A4 (210 × 297 mm), 10 sheets: C6050A
European A4 (210 × 297 mm), 10 sheets: C6065A
US letter, 10 sheets: C6049A
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how to order
To purchase printer supplies or accessories directly from HP, visit 
www.hp.com.

You can also purchase supplies and accessories from your nearest 
HP dealer.

Not all supplies and accessories are available in all regions.

http://www.hp.com
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specifications
To see specifications for the printer and printer accessories, click the 
appropriate heading below:

• printer specifications

• automatic two-sided printing module specifications

• infrared printing specifications

• minimum printing margins

• system requirements

• environmental statement

• regulatory notices
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printer specifications 

hp color inkjet printer cp1160

black text print speed *

Draft: Up to 17 pages per minute
Normal: Up to 8 pages per minute
Best: Up to 4 pages per minute

mixed text with color graphics print speed*

Draft: Up to 16 pages per minute
Normal: Up to 7 pages per minute
Best: Up to 4 pages per minute

*These are approximate figures. Exact speed varies with system 
configuration, software program, and document complexity.

black TrueType™ text resolution
(depending on paper type)

Draft: 600 x 300 dpi
Normal: 1200 x 600 dpi
Best: 1200 x 600 dpi

color resolution
(depending on paper type)

Draft: 600 x 300 dpi + PhotoREt
Normal: 2400 x 1200 dpi + PhotoREt
Best: 2400 x 1200 dpi + PhotoREt

photo paper printing resolution

PhotoREt
2400 x 1200 dpi (with some photo papers)

print technology

Drop-on-Demand thermal inkjet printing
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software compatibility

MS Windows compatible (95, 98, Me, 2000, and NT 4.0)
MS-DOS software programs

duty cycle

5,000 pages per month

memory

8 MB built-in RAM

processor

96 MHz processor

user interface

Icon-driven LCD panel
Cancel Button
Resume Button and Light
Power Button and Light

connectivity

Built in: Universal Serial Bus 2.0 fullspeed compliant 
IrDA version 1.1, 4 MBps

Via LIO modules: Centronics Parallel, IEEE 1284-compatible,
optional 10/100BaseT Ethernet

dimensions

Without Automatic Two-Sided Printing Module:

488 mm wide x 184.6 mm high x 379.5mm deep
19.21 in wide x 7.27 in high x 14.94 in deep

With Automatic Two-Sided Printing Module:

488 mm wide x 184.6 mm high x 433.5 mm deep
19.21 in wide x 7.27 in high x 17.06 in deep
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weight

Without Automatic Two-Sided Printing Module:

6.88 kg (15.17 lb) without print cartridges

With Automatic Two-Sided Printing Module:

7.45kg (16.42 lb) without print cartridges

operating environment

Maximum operating conditions:

Temperature: 41 to 104 degree F, 5 to 40 degrees C
Humidity: 15 to 80 percent RH non-condensing

Recommended operating conditions for best print quality:

Temperature: 59 to 95 degrees F or 15 to 35 degrees C
Humidity: 20 to 80 percent RH non-condensing

Storage conditions:

Temperature: –40 to 158 degrees F, –40 to 70 degrees C

maximum weight capacity

50 lbs. distributed weight

power consumption

2 watts maximum when off
4 watts average non-printing
40 watts average when printing

power requirements

Input Voltage: 100 to 240 Vac (±10%)
Input Frequency: 50/60 Hz (+3 Hz)
Accommodates the worldwide range of AC line voltages and frequencies.
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declared noise emissions in accordance with ISO 9296

Best Mode:

Sound power level, LWAd without duplexer: 5.6 B
Sound power level, LWAd with duplexer: 5.7 B

Sound pressure level, LpAm (bystander positions) without 
duplexer: 43 dB
Sound pressure level, LpAm (bystander positions) with
duplexer: 44 dB

Normal Mode:

Sound power level, LWAd without duplexer: 6.1 B
Sound power level, LWAd with duplexer: 6.3 B

Sound pressure level, LpAm (bystander positions) without 
duplexer: 48 dB
Sound pressure level, LpAm (bystander positions) with
duplexer: 50 dB

alignment

Skew: 

± .006 mm/mm (.006 in/in) on plain paper
± .009 mm/mm (.009 in/in) on plain paper with duplexer
± .010 mm/mm (.010 in/in) on hp transparency films

media weight

U.S. Letter Paper: 60 to 90 g/m2 (16 to 24 lb)
Legal Paper: 75 to 90 g/m2 (20 to 24 lb)
Banner Paper: 60 to 90 g/m2 (16 to 24 lb)
Envelopes: 75 to 90 g/m2 (20 to 24 lb)
Cards: Up to 200 g/m2 (110 lb index max)
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media handling

Sheets: up to 150
Banners: up to 20 sheets
Envelopes: up to 15
Cards: up to 60 cards
Greeting cards: up to 5 cards
Transparencies: up to 30
Labels: up to 30 sheets of labels (use only U.S. Letter– or A4–sized sheets)
Photo paper: up to 20 sheets

Output capacity:

Draft: up to 35 sheets
Normal: up to 50 sheets
Best: up to 50 sheets

media size

Paper:

U.S. Letter 216 x 279 mm (8.5 x 11 in)
Legal 216 x 356 mm (8.5 x 14 in)
Executive 184 x 279 mm (7.25 x 10.5 in)
A4 210 x 297 mm
A5 148 x 210 mm
B5-JIS 182 x 257 mm

Banner:

U.S. Letter 216 x 279 mm (8.5 x 11 in)
A4 210 x 297 mm

Envelopes:

U.S. No. 10 105 x 241 mm (4.12 x 9.5 in)
Invitation A2 111 x 146 mm (4.38 x 5.75 in)
DL 110 x 220 mm
C6 114 x 162 mm
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Index/Greeting Cards: 

76 x 127 mm (3 x 5 in)
102 x 152 mm (4 x 6 in)
127 x 203 mm (5 x 8 in)

A6: 105 x 148.5 mm

Hagaki: 100 x 148 mm

Labels:

U.S. Letter 216 x 279 mm (8.5 x 11 in)
A4 210 x 297 mm

Photo (with tear-off tab) 102 x 152 mm (4 x 6 in)
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automatic two-sided printing module 
specifications 
duty cycle

5,000 sides of pages per month

dimensions

324 mm (12.75 in) long x 133 mm (5.25 in) wide x 111 mm (4.37 in) high

weight

0.79 kg (1.75 lbs)

declared noise emissions in accordance with ISO 9296

Best Mode:

Sound power level, LWAd: 5.7 B

Sound pressure level, LpAm (bystander positions): 44 dB

Normal Mode:

Sound power level, LWAd: 6.3 B

Sound pressure level, LpAm (bystander positions): 50 dB

media weight

U.S. Letter and A4 paper: 60 to 90 g/m2 (16 to 24 lb)
Cards: up to 160 g/m2 (90 lb index maximum)
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minimum printing margins

Letter and Executive:

Left and right margins 6.4 mm (0.25 in)
Top and bottom margins 11.7 mm (0.46 in)

A4:

Left and right margins 3.4 mm (0.134 in)
Top and bottom margins 11.7 mm (0.46 in)

A5, B5, 5 x 8 in Card, and User Defined Size:

Left and right margins 3.17 mm (0.125 in)
Top and bottom margins 11.7 mm (0.46 in)

media size

Paper:

U.S. Letter 216 x 279 mm (8.5 x 11 in)
Executive 184 x 279 mm (7.25 x 10.5 in)
A4 210 x 297 mm
A5 148 x 210 mm
B5 182 x 257 mm

Cards:

127 x 203 mm (5 x 8 in)

media type

hp plain paper or HP bright white inkjet paper:

hp photo quality inkjet paper, matte finish:

hp photo quality inkjet paper, semi gloss:

hp premium inkjet heavyweight paper:

hp felt-textured greeting card paper, ivory/half-fold:

hp professional brochure & flyer paper, two-sided gloss

hp professional brochure & flyer paper, two-sided, matte finish



193

infrared printing specifications 
range

1 meter (3 feet)
30 degree cone

supported operating systems

Some operating systems supported by infrared technology include:

• Windows 2000
• Windows 98
• Windows CE
• Palm

supported devices

Some of the devices supported by infrared technology include:

• Laptop or notebook computer with infrared capability (including the 
HP Omnibook)

• Some personal digital assistants (including the Palm product line)
• Some Windows CE devices (including the HP Jornada)
• Cellular phones with infrared capability

supported protocols
• IrLPT
• OBEX
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minimum printing margins 
The printer cannot print outside a designated area of the page so your 
document content must be contained within the printable area. 

A4 paper

Left and Right Margins: 3.4 mm (0.134 in)
Top Margin: 1.8 mm (0.07 in)
Bottom Margin: 11.7 mm (0.46 in)

letter, legal, and executive paper

Left and Right Margins: 6.4 mm (0.25 in)
Top Margin: 1.8 mm (0.07 in)
Bottom Margin: 11.7 mm (0.46 in)

A5, B5, and user defined paper

Left and Right Margins: 3.2 mm (0.125 in)
Top Margin: 1.8 mm (.07 in)
Bottom Margin: 11.7 mm (0.46 in)

cards (3 x 5 in, 4 x 6, 5 x 8, and A6)

Left and Right Margins: 3.2 mm (0.125 in)
Top Margin: 1.8 mm (0.07 in)
Bottom Margin: 11.7 mm (0.46 in)

Hagaki postcards

Left and Right Margins: 3.2 mm (0.125 in)
Top Margin: 1.8 mm (0.07 in)
Bottom Margin: 11.7 mm (0.46 in)

envelopes

Left and Right Margins: 3.2 mm (0.125 in)
Top Margin: 1.8 mm (0.07 in)
Bottom Margin: 11.7 mm (0.46 in)
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banners - A4 (210 x 297 mm [8.27 x 11.7 in])

Left and Right Margins: 3.4 mm (0.134 in)
Top Margin: 1.8 mm (0.07 in)
Bottom Margin: 11.7 mm (0.46 in)
Between Page Margin: 0.0 mm (0.0 in)

banners - letter (216 x 279 mm [8.5 x 11 in])

Left and Right Margins: 6.4 mm (0.25 in)
Top Margin: 1.8 mm (0.07 in)
Bottom Margin: 11.7 mm (0.46 in)
Between Page Margin: 0.0 mm (0.0 in)

photo with tear-off tab

Left and Right Margins: 3.2 mm (0.125 in)
Top Margin: 3.2 mm (0.125 in)
Bottom Margin: 3.2 mm (0.125 in)
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system requirements
Your computer must meet the following minimum requirements:

Microsoft Windows NT 4.0 or 2000 

Minimum Processor Speed: Pentium 133 MHz
Required RAM: 64 MB
Required Free Hard Disk Space: 40 MB*

Microsoft Windows 95, 98, or Me

Minimum Processor Speed: Pentium 150 MHz
Required RAM: 32 MB
Required Free Hard Disk Space: 40 MB* 

DOS 3.3 or better

Minimum Processor Speed: 486
Required RAM: 4 MB
Required Free Hard Disk Space: 40 MB* 

* If you are printing photographs, you must have at least 100 MB free hard 
disk space. If your are printing at 2400 x 1200 dpi, you must have at least 
400 MB free hard disk space.
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environmental statement
Hewlett-Packard continuously improves the design processes of its deskjet 
printers to minimize the negative impact on the office environment and on the 
communities where printers are manufactured, shipped, and used. Hewlett-
Packard has also developed processes to minimize the negative impact of the 
disposal of the printer at the end of its printing life.

reduction and elimination
Paper use: The printer’s automatic/manual two-sided printing capability 
reduces paper usage and the resulting demands on natural resources. This 
printer is suited for the use of recycled papers according to DIN 19 309.

Ozone: Ozone-depleting chemicals such as CFCs have been eliminated from 
Hewlett-Packard manufacturing processes.

recycling
Design for recycling has been incorporated into this printer. The number of 
materials has been kept to a minimum while ensuring proper functionality 
and reliability. Dissimilar materials have been designed to separate easily. 
Fasteners and other connections are easy to locate, access, and remove 
using common tools. High priority parts have been designed to access 
quickly for efficient disassembly and repair. Plastic parts have been primarily 
designed in no more than two colors to enhance recycling options. A few 
small parts are colored specifically to highlight customer access points.

Printer packaging: The packaging materials for this printer have been 
selected to provide maximum protection for the least cost possible, while 
attempting to minimize environmental impact and facilitate recycling. The 
rugged design of the HP Deskjet printer assists in minimizing both packaging 
materials and damage rates.
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Plastic parts: All major plastics and plastic parts are marked according to 
international standards. All plastic parts used in the printer housing and 
chassis are technically recyclable and all use a single polymer.

Hazardous materials: This hp product contains the following materials that 
may require special handling at end-of-life:

• Lead in solder
• A lithium battery located on the motherboard
Battery Specifications

Battery Part Number:  Panasonic CR2032
Battery Material: Lithium
Battery type:  Button/Coin Cell Battery
Quantity per product:  1
Weight:  about 3 gram
Lithium type:  solid
Battery manufacturers:  Panasonic, Japan

Product longevity: To ensure the longevity of your HP Deskjet printer, HP 
provides the following:

• Extended warranty: HP SupportPack provides coverage for the HP 
hardware and product and all HP supplied internal components. HP 
SupportPack must be purchased by the customer within 30 days of 
purchase. Contact the nearest HP dealer about this service.

• Spare parts and consumables are available for five (5) years after 
production has stopped.

• Product take-back: To return this product and print cartridges to HP at 
the end of its useful life, call your local HP Sales or Service Office for 
instructions.
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energy consumption
This printer was designed with energy conservation in mind. This printer 
averages 4 watts in stand-by mode. Not only does this save natural 
resources, but it also saves money without affecting the high performance of 
the printer. 

This product qualifies for the ENERGY STAR Program (U.S. and Japan). 
ENERGY STAR is a voluntary program established to encourage the 
development of energy-efficient office products. 

ENERGY STAR is a US registered service mark of the US EPA. As an ENERGY 
STAR partner, Hewlett-Packard Company has determined that this product 
meets ENERGY STAR Guidelines for energy efficiency.

Energy consumption in off-mode: When the printer is off, a minimal amount of 
energy is still being consumed. Energy consumption can be prevented by 
turning the printer power off, then disconnecting the end of the printer power 
cord from the electrical source.
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regulatory notices

hewlett-packard company
This device complies with part 15 of the FCC Rules. Operation is subject to 
the following two conditions: 

• This device may not cause harmful interference, and 
• This device must accept any interference received, including 

interference that may cause undesired operation.
• Pursuant to Part 15.21 of the FCC Rules, any changes or 

modifications to this equipment not expressly approved by Hewlett-
Packard Company may cause harmful interference, and void your 
authority to operate this equipment. Use of a shielded data cable is 
required to comply with the Class B limits of Part 15 of the FCC Rules.

For further information, contact:

Hewlett-Packard Company
Manager of Corporate Product Regulations
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501
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note
This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to part 15 of the FCC rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the 
instructions, can cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

LED indicator statement
The display LEDs meet the requirements of EN 60825-1.
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